
Overview
Total Recorder is a sound recording and playing program. It records analog sound digitized 
by a sound card, as well as sound generated, or requested, by other computer programs, 
such as RealPlayer, Windows Media Player, Quick Time, WinAmp, and many others. Recorded
sound is saved in wave-file format, or you can use external programs to save recorded 
sound in MP3 or Ogg Vorbis format. 

For example, you can use Total Recorder to record:

· audio from the Internet, either audio files or live streams

· music from a game program

· a conversation, if you use an Internet telephony program.

Total Recorder uses a virtual sound driver to capture the sound output from another 
program. By installing this driver, and setting this device as the default, different sound 
reproducing programs send their output stream to Total Recorder's driver and not to the 
driver of a real device. Total Recorder then passes the information to the sound card driver.

Total Recorder has a built-in scheduler. This allows you to automatically record a show at a 
given time for later playback or you can use the scheduler as an alarm. Note that this latter 
function does not require registration.



Total Recorder Editions

Total Recorder is distributed as the Standard Edition (SE), the Professional Edition (PE), or the
Developer Edition (DE).

With Total Recorder Professional Edition you receive the following:

· All the features provided by Total Recorder Standard Edition.

· Many other additional features, such as the ability to edit sound data, advanced 
scheduler settings, and much more.

With Total Recorder Developer Edition you receive the following:

· All the features provided by Total Recorder Professional Edition.

· Interfaces that give you the ability to write your own application, using COM and 
Automation technologies, to control Total Recorder. Your application can include, or 
extend, Total Recorder's functionality as you choose.

Parts of this document that deal with a particular Total Recorder edition are noted 
throughout. The screen captures in this document are for Total Recorder Professional Edition.
Controls or elements that are not available in the Standard Edition are noted.

For information on writing an application that uses the Total Recorder's objects/interfaces 
provided by Total Recorder Developer Edition, refer to the Automation On-Line Help 
(TotRecAuto.hlp).

You can use the “Help”-“About” menu to see which edition is installed on your computer.



Total Recorder Standard Edition Version 4.1

In addition to maintenance, Version 4.1 Standard Edition includes the following changes:

· Full support for the Ogg Vorbis format. For more information, see "Using the Ogg Vorbis 
Tab" and “Working with Ogg Vorbis Format”.

· "Jump to time" feature lets you easily navigate to a particular point in a sound file.

· Improved displays of the properties of files and recordings.

· Improved user interface and other minor enhancements.



Total Recorder Professional Edition Version 4.1

In addition to maintenance and new features added to Standard Edition, Version 4.1 includes
the following changes:

· Sound image visualization. This helps you navigate in sound data and allows you to see 
portions of sound with different characteristics.

· Ability to close the player after a scheduled recording completes. For more information, 
see “Scheduling a Job”.

· The Split mode feature has been enhanced so that a file can be split based on a low level
of sound being recorded. For more information, see “Using the Split recording conditions 
Dialog”.

· "Split now" feature has been added.

· Advanced stop recording conditions have been extended. A recording can be stopped 
based on a low level of sound being recorded. For more information, see “Using the 
Advanced stop recording conditions Dialog”.



Version Information

Version 4.1
Total Recorder Standard Edition

· Full support for the Ogg Vorbis format.

· "Jump to time" feature lets you easily navigate to a particular point in a sound file.

· Improved displays of the properties of files and recordings.

· Improved user interface and other minor enhancements.

Total Recorder Professional Edition

· Sound image visualization. This helps you navigate in sound data and allows you to see 
portions of sound with different characteristics.

· Ability to close the player after a scheduled recording completes.

· The Split mode feature has been enhanced so that a file can be split based on a low level
of sound being recorded.

· "Split now" feature has been added.

· Advanced stop recording conditions have been extended. A recording can be stopped 
based on a low level of sound being recorded.

Version 4.0
Total Recorder Standard Edition

· The ability to directly use playback and recording devices. For more information, see 
"Using the System Tab".

· Extended functionality of the "Undo" and "Redo" operations. For more information, see 
"Editing a Sound File".

· Sensitivity of the sound level indicators has been increased. For more information, see 
"The Total Recorder dialog overview".

· Improved user interface.

Total Recorder Professional Edition

Total Recorder Professional Edition Version 4.0 is the first version in a family of 
professional editions. The Professional Edition covers all features provided by the 
Standard Edition and provides the following additional features:

· The ability to edit sound data. You can use the Clipboard for cut, copy, and paste 
operations, and insert a sound file anywhere in a recording. For more information, see 
"Editing a Sound File".

· Split mode. A recording can be automatically split into separate files based on different 
conditions. For example, a new file can be created once a recording reaches a certain 



size or after a specified amount of time. For more information, refer to the "Split mode 
overview".

· Advanced file name generation rules let you specify options for the names of 
automatically generated files. These can be files created in split mode or by a scheduled 
job. For more information, refer to the "Specifying File Name Generation Rules".

· Advanced options for automatically stopping a recording. For example, you can restrict a 
recording by time or size, or specify a time limit for no sound being recorded. For more 
information, refer to the "Using the Advanced stop recording conditions Dialog".

· The ability to play an Internet transmission when a scheduled recording starts. For more 
information, refer to the "Tuning into Internet Transmissions".

· Other minor enhancements.

Version 3.4
· The ability to regulate the level of sound being recorded from a software source.

· Total Recorder can preserve pauses in a recording.

· The incompatibility with Lame encoder versions 3.90 and 3.91 is resolved.

· A frequency for writing cached data can be set. This can help prevent clicks and gaps in 
recordings.

· Diagnostic tools are enhanced.

· Compatibility with some software has been improved.

Version 3.3
· The sound level for each channel is displayed separately.

· The ability to schedule a job to run on weekdays or weekends.

· Version 3.3 is completely compatible with Windows XP.

· Other minor improvements.

Version 3.2
· Pre-recording mode. In this mode Total Recorder records continuously and stores the last 

specified number of seconds of data. When you push the Record button, this data is 
added to the beginning of your recording.

· The ability to edit ID3v2 tags.

· Automatic removal of gaps while recording in software mode.

· Improved stability and compatibility.

Version 3.0
· The ability to play and record compressed sound using installed codecs.



· The ability to use external MP3 modules for recording in MP3 format.

· Compatibility with Windows Millennium Edition.

· A Fast-save capability.

· Automatic stop after a specified amount of recording time.

· Interface improvements.

Version 2.2
· Support for Windows NT 4.0 and Windows 2000.

· The ability to resample a recording (i.e. change sound stream parameters). Resampling 
can be done either during the recording process or when you save a recording. 

· The maximum recording size is no longer limited to 2GB. It is now possible to record up 
to 49 continuous days. However, since an individual .wav file has a limit of 4GB, a long 
recording must be broken into pieces in order for it to be saved.

· A save progress indicator.

· The ability to increase the priority of the Total Recorder program and provide cleaner 
recordings.

· The ability to normalize the volume of a recording.

Version 2.1
· Accelerated recording/converting. This allows you to convert a sound file to standard 

wave format without listening to it. This operation normally takes a fraction of the time it 
would require to play the file.

· Markers. These allow you to select and save only part of a recording or part of an existing
wave file.

· The ability to continue recording to the same file after it was stopped.

· A level indicator reflects the amplitude of a signal during recording and playback.

· The ability to have more than one open copy of Total Recorder (like in version 1.0).

Version 2.0
· Capturing and recording of sound streams that programs request from a sound card. This

allows full duplex recording of Internet phone conversations when using programs such 
as NetMeeting and VoxPhone.

· Recording from CD, microphone and other input lines.

· Built-in scheduler that allows you to program jobs (record or playback) to start at a given 
time, similar to programming a VCR.

· Command line parameters that allow you to use an external scheduler such as Microsoft 
Task Scheduler to schedule a recording or playback.



· Automatic installation and uninstallation of the virtual device driver.



Trademarks and copyright rights
Musical compositions and artwork are protected under international copyright laws. 
Unauthorized copying of those works may violate the rights of the owner and may expose 
you to civil and criminal penalties. You may not use the Total Recorder product to violate the 
copyright rights of others. High Criteria Inc. does not authorize you to use Total Recorder for 
the purpose of violating the copyright rights of others nor does it license or sell Total 
Recorder to you for this purpose. If you have any questions or doubts concerning your use, 
or copying, of someone else’s works, please confirm in advance that you are authorized to 
use and copy the work in the manner you intend.

Other product and company names appearing in High Criteria Inc. products and materials 
are used for identification purposes only and may be trademarks or registered trademarks of
their respective companies. Registered and unregistered trademarks used in any High 
Criteria Inc. products and materials are the exclusive property of their respective owners.



System Requirements
To use Total Recorder, you need the following:

· an IBM compatible computer

· a sound card 

· Microsoft Windows 95, 98, ME (Millennium Edition), 2000, Windows NT 4.0 or 
Windows XP.



Program Restrictions
Total Recorder records wave-type sound streams only. It cannot record any of the following:

· Sound reproduced by means of MIDI-output, unless your sound card has a special MIDI 
synthesis line (most sound cards have this feature).

· Sound reproduced by programs developed for systems other than Windows 95/98/Me or 
NT/2000/XP (e.g. DOS programs executing in DOS sessions).

Total Recorder can record only one output and one input sound stream at a time. If a sound 
card allows simultaneous output of several wave-streams and can mix these streams itself, 
then Total Recorder can only record one of these streams.



How Software Recording works
The following diagrams illustrate, in more detail, how Total Recorder works when it captures 
and record sound played back or requested by other computer programs. 



How Software Accelerate Recording works
The following diagrams illustrate, in more detail, how Total Recorder works when it speeds 
up (or down) capturing and recording sound played back other computer programs. In this 
mode you could not hear a sound when a recording is in process.



How Board Recording works
The following diagrams illustrate, in more detail, how Total Recorder works when it records 
sound digitized by a sound card. This includes a microphone, CD or other input lines.



Package content

Total Recorder is shipped via the Internet, as a self-extracting or regular archive, and 
consists of the files listed below. The following table indicates each file name, a description, 
the environments in which each file is required, and the Total Recorder editions in which 
each file exists.

File Description Required 
on 
Windows 
95/98/ME

Required 
on 
Windows 
2000/NT 4/
XP

Edition

TotalRecorder.exe Total Recorder 
program

Yes Yes All

TotRecSched.exe scheduler program No Yes All

DrvTR95M.drv device driver Yes No All
DrvTRNTM.dll device driver No Yes All

DrvTR95L.dll device driver library Yes No All
DrvTRNTL.dll device driver library No Yes All

DrvTR95.vxd virtual device driver Yes No All
DrvTR95.inf driver installation file Yes No All

OEMSETUP.inf driver installation file No Yes All
TotalRecorder.hlp help file Yes Yes All

TotalRecorder.cnt help content file Yes Yes All
Setup.exe Install/uninstall 

program
Yes Yes All

DrInst.exe driver install/uninstall
program

Yes No All

License.txt License agreement 
file

Yes Yes All

Readme.txt Read-me first file Yes Yes All

Registration.txt Registration form Yes Yes All
TotalRecorder.tlb Type library Yes Yes DE

Automation\ 
TotRecDemoClient.exe

demo client 
application

Yes Yes DE

Automation\ TotRecAuto.hlp Automation support 
help

Yes Yes DE

Automation\ TotRecAuto.cnt Automation support Yes Yes DE



help content file
Automation\ 
TotalRecorder_i.h, 
TotalRecorder_i.c

Sources for using 
Total Recorder objects
in C++ client 
applications

Yes Yes DE

Automation\Samples\CPP\*.* C++ samples for 
demonstrating Total 
Recorder's 
Automation support

Yes Yes DE

Automation\Samples\VBA\
*.*

Visual Basic samples 
for demonstrating 
Total Recorder's 
Automation support

Yes Yes DE

Installing Total Recorder overview

Beginning with version 3.0, Total Recorder uses a new format of the registration key. If you 
install version 4.1 over a version of Total Recorder that is older than 3.0, it will be 
unregistered until you enter a new registration key. Beginning with version 4.1, Total 
Recorder Developer Edition uses a new format of the registration key. If you install version 
4.1 Developer Edition over a registered version of Total Recorder, it will be unregistered until 
you enter a new registration key. The “ Registering Total Recorder”   section describes how to   
obtain a key, once you have installed and configured the software.

If you install version 4.1 (Standard Edition) over a registered version of Total Recorder     3.x, a   
new registration key is not required.

If you install version 4.1 (Professional Edition) over a registered version of Total Recorder     4.0   
(Professional Edition), a new registration key is not required.

Note: Different editions of Total Recorder have different registration keys.   For   
example, you cannot use the registration key for Total Recorder Standard Edition in either 
Total Recorder Professional Edition or in Total Recorder Developer Edition.

Specific Information for Windows NT
Specific Information for Windows 2000/XP

Installation Steps



Specific Information for Windows NT
To install Total Recorder on Windows NT, you need the "Load and Unload Device Drivers" 
user right. Normally, only administrative users have this right.

To use the Total Recorder program, you do not need any special rights. However, the Total 
Recorder setup program changes settings only for the user who installed the program. Any 
other user must manual set the Total Recorder driver as a preferred device (see 
Installing/Uninstalling the Total Recorder Driver Manually).



Specific Information for Windows 2000/XP
Windows 2000 and Windows XP are members of the Windows NT product family. All of the 
information in the previous section (Specific Information for Windows NT) applies to Windows
2000/XP.

If you are planning to upgrade your Windows 95/98/ME system to Windows 2000/XP, you 
must take the following steps:

1. Before upgrading your Windows environment, uninstall Total Recorder.
2. After the upgrade is complete, reinstall Total Recorder.

3. Re-register Total Recorder. You should have your registration information available.

Note: Total Recorder will not work if you simply upgrade your Windows environment to 
Windows 2000/XP without taking the steps described above. 



Installation Steps

Version 4.1 cannot coexist on the same machine with any previous version (1.0, 2.0, 2.1, 
2.2, 3.0, 3.2, 3.3, 3.4 or 4.0). The different editions (Standard Edition, Professional Edition 
and Developer Edition) of Total Recorder cannot be installed on the same computer.

Take the following steps to install Total Recorder on your PC:

1. Download the self-extracting archive and run it
For the Standard Edition:
TR41SE.exe (http://www.highcriteria.com/download/TR41SE.exe)

For the Professional Edition:
TR41PE.exe (http://www.highcriteria.com/download/TR41PE.exe)

For the Developer Edition:
TR41DE.exe (http://www.highcriteria.com/download/TR41DE.exe)

OR

Download the archive, as listed below. Unzip it and run Setup.exe. Note that you must 
unzip the entire archive not just the Setup.exe file.
For the Standard Edition:
TR41SE.zip (http://www.highcriteria.com/download/TR41SE.zip)

For the Professional Edition:
TR41PE.zip (http://www.highcriteria.com/download/TR41PE.zip)

For the Developer Edition:
TR41DE.zip (http://www.highcriteria.com/download/TR41DE.zip)

If you have a previous version installed, you are prompted to uninstall it. Press “OK” to 
continue with the installation. Press “Cancel” if you want to exit the installation program 
without installing the software.
The installation program creates a directory for Total Recorder, copies all of the files to 
that directory, creates a Program Group called Total Recorder, installs a driver, and sets it
as the default device for both playback and recording.

2. After installing Total Recorder, you must restart Windows.
Tip: Create a shortcut to Total Recorder and place it on your desktop. This gives you single-
click access to Total Recorder. 



Installing/Uninstalling the Total Recorder Driver Manually
If you experience problems with the automatic installation or uninstallation of the Total 
Recorder driver, you can install/uninstall this driver manually as described below. Otherwise, 
skip to the section "Configuring Total Recorder overview".

You need to install a virtual driver so that Total Recorder is able to record as well as play. This
process is similar to that used for installing a sound card driver. The procedure you use 
depends on the version of Windows you are running.

Installing the Driver Manually - Windows 95, Windows 98 or Windows ME

Use the following procedure.

1. Select "Start"- "Settings"- "Control Panel". 

2. Click "Add New Hardware".
3. For Windows 95: Answer "No" to the question "Do you want Windows to search for your

new hardware?"

For Windows 98/ME: Select "No - I want to select the hardware from a list" to the 
prompt "Windows can search for hardware that is not Plug and Play compatible or select 
from a list".

4. Select "Sound, video and game controllers" from the list of Hardware types.

5. Click "Have disk" instead of choosing from the list of manufacturers and models.
6. Point to the directory you selected during the installation of Total Recorder (where 

DrvTR95.inf resides). 
7. There will only be one driver entry in this .inf file - Wave sound driver for the Total 

Recorder, and it will be selected by default. Click "OK" or press Enter.
8. After clicking the "Finish" button, wait patiently for a wizard dialog window to disappear. 

It may take about one minute.

Installing the Driver Manually - Windows NT 4.0

Use the following procedure.

1. Select "Start"- "Settings"- "Control Panel". 

2. Click "Multimedia".
3. Select the "Devices" tab.

4. Click "Add".
5. Click "Unlisted or Updated driver" from the list of manufacturers and models.

6. Point to the directory you selected during the installation of Total Recorder (where 
oemsetup.inf resides). 

7. There will only be one driver entry in this directory - Wave sound driver for the Total 
Recorder, and it will be selected by default. Click "OK" or press Enter. 



8. After the installation is complete, reboot your computer.

Installing the Driver Manually - Windows 2000

Use the following procedure.

1. Select "Start"- "Settings"- "Control Panel".

2. Click "Add/Remove Hardware".
3. Click "Next" to continue.

4. Select "Add/Troubleshoot a device" and click "Next".
5. Select "Add a new device" and click "Next".

6. Select "No, I want to select the hardware from a list" and click "Next".
7. Select "Sound, video and game controllers" and click "Next".

8. Click "Have disk" instead of choosing from the list of manufacturers and models.
9. Point to the directory you selected during the installation of Total Recorder (where 

oemsetup.inf resides).
10. There will only be one driver entry in this directory - Wave sound driver for the Total 

Recorder, and it will be selected by default. Click "Next".
11. Click "Next" again. A "Digital Signature Not Found" dialog appears.

12. Click "Yes". A "Files Needed" dialog appears.
13. Enter the same name as in step 9.

14. Click "Finish".
15. Close all applications and reboot your computer.

Installing the Driver Manually - Windows XP

Use the following procedure.

1. Select "Start"- "Control Panel".
2. Click "Add Hardware".

3. Click "Next" to continue.
4. Select "Yes, I have already connected the hardware" and click "Next".

5. Select "Add a new hardware device" (at the bottom of the list) and click "Next".
6. Select "Install the hardware that I manually select from a list (Advanced)" and click 

"Next".
7. Select "Sound, video and game controllers" and click "Next".

8. Click "Have disk" instead of choosing from the list of manufacturers and models.



9. Point to the directory you selected during the installation of Total Recorder (where 
oemsetup.inf resides).

10. There will only be one driver entry in this directory – the Wave sound driver for Total 
Recorder, and it will be selected by default. Click "Next".

11. Click "Next" again. A "Hardware Installation" dialog appears with the warning that the 
software has not passed Windows Logo testing.

12. Click "Continue Anyway". A "Files Needed" dialog appears.
13. Enter the same name as in step 9.

14. Click "Finish".
15. Close all applications and reboot your computer.

Setting Preferred Devices

After installing the virtual device driver manually, you must set this device as your default. 

1. Select "Start"- "Settings"- "Control Panel" (for Windows XP select "Start"- "Control 
Panel").

2. Select "Multimedia" (for Windows ME, Windows 2000 - "Sounds and Multimedia", for 
Windows XP - "Sounds and Audio Devices") and click the "Audio" tab.

3. Review the "Preferred device" list in the "Playback" section. Write down the name of the 
default device and then proceed to the next step. Important: This information is 
required if you uninstall Total Recorder. 

4. Select the "Playback through Total Recorder" entry.

5. Review the "Preferred device" list in the "Recording" section. Write down the name of the
default device and then proceed to the next step. Important: This information is 
required if you uninstall Total Recorder. 

6. Select the "Record through Total Recorder" entry.



7. You should also check the "Use preferred devices only" box (or "Use only preferred 
devices").

Uninstalling the Driver Manually - Windows 95, Windows 98, or Windows ME

Take the following steps.

1. Select "Start"- "Settings"- "Control Panel". 
2. Select "System" and click the "Device Manager" tab.

3. Select "Sound, video and game controllers".
4. Highlight "Wave sound driver for the Total Recorder".

5. Click "Remove".
6. Close all applications and reboot your computer.

7. Verify that your preferred playback and recording devices are set correctly. You can use 
the Windows system dialog ("Start"- "Settings"- "Control Panel" (for Windows XP "Start"- 
"Control Panel"), "Multimedia", or "Sounds and Multimedia", or "Sounds and Audio 
Devices", "Audio tab"), or use the Total Recorder menu items ("Options"- "System 
settings"), and select the devices that were set before the installation of Total Recorder. 

Uninstalling the Driver Manually - Windows NT

Take the following steps.

1. Select "Start"- "Settings"- "Control Panel".
2. Click "Multimedia".



3. Select the "Devices" tab.

4. Select "Audio Devices".
5. Highlight "Audio for Wave sound driver for the Total Recorder".

6. Click "Remove".
7. Close all applications and reboot your computer.

8. Verify that your preferred playback and recording devices are set correctly. You can use 
the Windows system dialog ("Start"- "Settings"- "Control Panel", "Multimedia", "Audio" 
tab), or use the Total Recorder menu items ("Options"- "System settings"), and select the
devices that were set before the installation of Total Recorder.

Uninstalling the Driver Manually - Windows 2000

Take the following steps for Windows 2000. Note that only a manually installed driver can 
be removed manually.

1. Select "Start"- "Settings"- "Control Panel".
2. Click "Add/Remove Hardware".

3. Click "Next" to continue.
4. Select "Uninstall/Unplug a device" and click "Next".

5. Select "Uninstall a device" and click "Next".
6. Select "Wave sound driver for the Total Recorder" and click "Next".

7. Select "Yes, I want to uninstall this device" and click "Next".
8. Click "Finish".

9. Close all applications and reboot your computer.
10. Verify that your preferred playback and recording devices are set correctly. You can use 

the Windows system dialog ("Start"- "Settings"- "Control Panel", "Sounds and 
Multimedia", "Audio" tab), or use the Total Recorder menu items ("Options"- "System 
settings"), and select the devices that were set before the installation of Total Recorder.

Uninstalling the Driver Manually - Windows XP

Take the following steps for Windows XP. Note that only a manually installed driver can be 
removed manually.

1. Select "Start"- "Control Panel".
2. Click "Sounds and Audio Devices".

3. Select the "Hardware" tab.
4. Select "Wave sound driver for the TotalRecorder" and click "Properties".

5. Select the "Driver" tab.



6. Click "Uninstall". A "Confirm Device Removal" dialog appears.

7. Click "OK".
8. Click "OK" in the "Sounds and Audio Devices Properties" dialog.

9. Close all applications and reboot your computer.
10. Verify that your preferred playback and recording devices are set correctly. You can use 

the Windows system dialog ("Start"- "Control Panel", "Sounds and Audio Devices", 
"Audio" tab), or use the Total Recorder menu items ("Options"- "System settings"), and 
select the devices that were set before the installation of Total Recorder.



Configuring Total Recorder overview
The configuration program allows you to set the following:

· suppression of system sounds

· preferred playback and recording devices

· priority of Total Recorder program

· directory for temporary files

· default directory

· action for making a new recording over a previous one

· split mode settings (Professional and Developer Editions only)

· file name generation rules (Professional and Developer Editions only)

· resampling algorithm

· external programs for MP3 encoding

· default format (RIFF-WAVE or MP3) and ID3 tags (ID3v1 and ID3v2) for MP3 files

· a default tag for Ogg Vorbis files

· pre-recording parameters

· debug mode for driver.

To configure Total Recorder:

1. Start the Total Recorder program.

2. Either select “Options”- “Settings” or click the  button on the Main toolbar. You are 
presented with a dialog box with the following tabs: 

Tab Use this tab to set options for …
System System sounds, audio playback and recording 

devices, preferred audio devices when Total Recorder 
isn’t active, priority of Total Recorder program

Open/save Folder for temporary files, default Open/SaveAs 
folder, action for making new recording over previous 
one

Split (Professional and 
Developer Editions only)

Split mode parameters, file name generation rules

Algorithm Frequency conversion algorithm
MP3 Program for encoding to MP3, header format, ID3 tags
Ogg Vorbis Default tag for Ogg Vorbis files
Pre-recording Number of seconds to pre-record, activate pre-

recording mode
Debug Trace file, internal debug information



Using the System Tab
The dialog looks like this:

Each of the configuration options is described below.

System sounds 

To prevent system sounds from interrupting your recording, check "Turn off sounds assigned 
to system events". This is the default and the recommended setting. Your system sounds will
return when you close Total Recorder.

Audio playback and recording devices

These devices are the names of the real drivers used for playback and recording. This is 
where Total Recorder redirects its input and output sound streams. The installation program 
automatically sets these values according to your current system settings and usually you 
do not need to change them.

Use directly

The “Use directly” check box can be used for Playback and Recording. If this option is set, 
Total Recorder plays back/records sound bypassing its own driver.

Setting this option may be useful if you experience problems with the Total Recorder driver.

Setting the “Use directly” option for a playback device lets you play back sound using Total 
Recorder and other sound programs (e.g. screen reader) simultaneously if your sound board 
allows multi-streaming playback. You can also have two instances of Total Recorder running. 
While one instance of Total Recorder records in accelerated recording mode, another (with 
the flag enabled) can play sound data.

If the device is set to "(Auto select)" then the “Use directly” check boxes are disabled.

Preferred audio devices when Total Recorder isn't active



This identifies the use of the Total Recorder driver. You can choose from the following:

Total Recorder driver (recommended) - does not change the preferred devices 
for playback and recording. The Total Recorder installation program sets the Total 
Recorder driver as the preferred device    (i.e. "Playback through TotalRecorder" and 
"Record through TotalRecorder"). This driver works all the time and passes sound 
through it regardless of Total Recorder being active. This is normally transparent to 
the user. 

Audio playback and recording devices selected above – this is recommended if 
the Total Recorder driver conflicts with some other programs and the conflict cannot 
be resolved by reconfiguring those programs. For more information, refer to the 
"Sound system or playback programs not working properly" section. In this mode, 
Total Recorder sets its driver as a preferred device when it starts and your specified 
real drivers (not Auto Select) when you exit.
In this mode, Total Recorder cannot record sound that starts before it was started. You
must start Total Recorder before your playback program.
Use preferred devices only - this flag should only be used if you have selected 
"Audio playback and recording devices selected above". Select the value that will be 
set when Total Recorder exits. It is always on when Total Recorder is active. 

High priority

Selecting this option raises the priority of the Total Recorder program. Because sound 
recording is a real-time process, any interruption can lead to skips, clicks, gaps, etc. This 
setting helps eliminate these problems and provides cleaner recordings. 



Using the Open/Save Tab
The dialog looks like this:

Each of the configuration options is described below.

Folder for temporary files
The size of recording files can be quite large. Because of this, Total Recorder saves recorded 
information, not in memory, but in a temporary file. You can specify the directory for this file,
if you wish.
When you first start the Total Recorder program, it sets the directory for temporary files 
based on the following:

· If the system environment variable TMP exists, it uses its value.

· Else, if the TEMP system environment variable exists, it uses its value.

· Otherwise, it uses the directory where the program is installed.

It is recommended that you store temporary files on the same hard drive where you will 
save your recordings. Otherwise, a full copy operation will be required and this will be time 
consuming for large files.

It is not recommended that you store temporary files on a compressed drive. If the folder for
temporary files is on a compressed NTFS drive, then you should remove compression from 
the folder.

Flush the temporary file every nn seconds

This option causes the operating system to write data to your hard drive every nn seconds, 
instead of keeping it in the processor’s cache. If this mode is set and your computer shuts 
down, or restarts abnormally, your sound recording can be found in the folder for temporary 
files with a file name of ~TRr1.wav|mp3 (~TRr2.wav|mp3, ~TRr3.wav|mp3, ...).



Setting this mode can sometimes result in sound defects, such as clicks or gaps, when 
making long recordings from some soundboards. For more information, refer to the section 
”Troubleshooting, Symptom - Sound recorded with gaps, Possible Cause #4”.

It is not recommended that you change the default flush value of 5 seconds.

Default Open/SaveAs folder

When you first start Total Recorder, the default directory for opening and saving files is the 
directory from which the Total Recorder program was started. Subsequently, Total Recorder 
can use the previously used directory as the default (select "Last used folder") or you can 
specify the default directory yourself (select "This folder" and specify the location). 

Action for making new recording over previous one

You can select one of the following options to specify the action to take when you attempt to
record over an existing recording:

Delete the old one without confirmation – Clicking the “Record” button 
overwrites and destroys the previous recording unless it has not yet been saved (in 
full) to a file.

Save the old one with confirmation, if not saved – similar to the above, but if 
the recording has not been saved, you are prompted to save it. Recording does not 
start until you respond.

Append/Insert – a new recording is appended to, or inserted into, an existing 
recording regardless of it being saved. Insert mode is available only with the 
Professional and Developer Editions.

Note:
If you want to create a new file, you must explicitly select “New” from the “File” menu or 
click the  button in the main toolbar. Sound parameters (i.e. sample rate, mono/stereo, 
8bit/16bit) are always inherited from the recording. Even if different parameters are set in 
the “Recording source and parameters” dialog they will not be in effect unless you implicitly 
create a new file. This note refers to all modes except for split mode.

Notes for Professional and Developer Editions Users:
You can switch between Append and Insert modes using the "Play/Record" menu ("Append 
recording mode" and "Insert recording mode" items), or by clicking the appropriate button (

 for append mode, 
 for insert mode). If either the "Delete the old one without confirmation" or "Save the old 

one with confirmation, if not saved" mode is set, then you cannot switch between Append 
and Insert modes.
Turning on split mode causes the "Save the old one with confirmation, if not saved" option to
be set automatically.

A recording is not considered saved unless it was saved in full; partial recordings are not 
considered saved files.



Using the Split Tab (Professional and Developer Editions only)
This dialog lets you set split mode parameters and file name generation rules. It looks like 
this:

Split mode

Select the “Split mode” check box to activate split mode. Setting this mode causes a new file
to be created for each recording session (from start to stop). 

Turning on split mode causes the "Save the old one with confirmation, if not saved" option to
be automatically set.

Conditions

You can specify additional conditions for creating new files during a recording by pressing
the "Conditions…" button. For more information, refer to the "Split mode overview".

File name generation rules

Created files initially have names generated on the basis of rules specified in the "File names
generation rules" dialog. You can customize these names using the “Rules” button and 
selecting various options.

An example of such a file name is TR_new_album_001.wav. For more information, refer to 
the ”Specifying File Names Generation Rules" section.



Using the Algorithm Tab
This dialog lets you set the frequency conversion algorithm and looks like this:

Frequency conversion algorithm
Select one of the following:

Use Total Recorder algorithm – use Total Recorder’s internal algorithm. This is the 
default and recommended value. It provides a reasonable compromise between 
speed and quality.

Use system codec – in most cases, this is Microsoft PCM Converter. It is very fast 
but the quality may be unacceptable.



Using the MP3 Tab
Use this tab if you plan to use Total Recorder with MP3 format. Before working with this 
dialog, you should review "Working with MP3 Format".

The dialog looks like this:

Each of the configuration options is described below.

Select program for encoding to MP3
You can select from the following:

Unable to encode Mpeg Layer 3 – this item is the first in the list if there is no MP3 
codec installed on your system. If you select this item, Total Recorder will not be able 
to create MP3 files and "MPEG Layer 3: press F1 to get help" appears in the list of 
sound formats. You can use F1 to display some links to find MP3 encoders.

[Default codec] – this item is the first in the list if there is at least one MP3 codec on
your system. If you select this item, Total Recorder relies on the system to select an 
appropriate codec. 

(Name of a particular codec) – one of these entries appears for each MP3 codec in
the system. You can select any codec from the list. Normally there is only one MP3 
codec installed, in which case you can either select it here or select [Default codec] 
as above.

Blade encoder (dll) – use BladeEnc.dll to encode to MP3. Total Recorder will show 
this item regardless of whether this DLL exists on your system. However, you can 
only save this setting if you provide a full path to BladeEnc.dll in the Location field. 

Lame encoder (dll) –use Lame_Enc.dll to encode to MP3. Total Recorder will show 
this item regardless of whether this DLL exists on your system. However, you can 
only save this setting if you provide a full path to Lame_Enc.dll in the Location field.

Location

This identifies the full path for the external encoding program. Total Recorder will locate the 



program itself if it is in one of the PATH directories. Otherwise, click Change and enter the 
location. For example:

Version

Total Recorder checks the version of the external program. Some older versions are not 
supported, in which case an error message appears and you will need to download a newer 
version.

Flags

MP3 frame headers contain different flags. Note, that setting a flag is available only for 
encoding using dll. You can select from the following.

Copyright – the flag indicating whether the audio is copyrighted.

Private – may be freely used for specific needs.

Original – the flag indicating whether the audio is original media.
For stereo mode

MP3 format supports different versions of encoding stereo audio signals. When Total 
Recorder displays a dialog for selecting a format, it only includes mono or stereo. If stereo is 
specified, it will be encoded according to the mode selected in this tab.

You can select from the following, although some modes may not be available for some 
encoding programs:

Stereo – each channel is encoded separately but not necessarily the equal amount 
of space is allocated for each channel. For example, the encoding program may 
allocate a larger part to one channel based on the actual content of the sound 
stream.

Joint stereo – both channels are encoded together. The average of the two channels
is calculated and encoded. The difference between channels is also encoded but with 
a lower bit rate. This method saves some space but the quality may suffer. This mode
is not recommended for high-quality recordings with high bit rates (i.e. more than 
192 kbit/sec.).

Dual channel – each channel is encoded separately and independently. This is 
recommended where the content is not actually a stereo recording but two 
independent sound streams.

Quality

You can select the desired quality if the encoding program allows it. The better the quality 
you select, the slower the encoding will be.

File type

You can select the desired header format for MP3 files – either RIFF-WAV (WAV-MP3) or "pure"



MP3. Click the Change button to change this setting. You can override this default value 
when you save a recording but it requires a full copy of the file.

ID3 tag

You can add an ID3 tags (ID3v1, ID3v2 or both) to pure MP3 files but not to RIFF-WAV files. 
These tags can contain such information as the artist name, the album, etc. You can click the
Change button to set a default. For more information, refer to the "Using the MP3 properties 
dialog".

You can override this default value when you save a recording. For the ID3v1 tag, it is fast 
and does not require a full copy. Changing the ID3v2 tag may require a full copy of the file.

Note: The ID3v1 tag is completely supported. For the ID3v2 tag, only Version 2.3 and below 
is supported.



Using the Ogg Vorbis Tab
Use this tab if you plan to use Total Recorder with Ogg Vorbis format. You can set a default 
tag for Ogg Vorbis files, and review the version of the Ogg Vorbis support library 
(vorbishc.dll) that you have installed. Before working with this dialog, you should review 
"Working with Ogg Vorbis Format".
The dialog looks like this:

The dialog displays the version of the Ogg Vorbis support library (vorbishc.dll) that is 
currently installed. If vorbishc.dll is not installed, an appropriate message is displayed.

Tag

You can add a tag to Ogg Vorbis files. Each tag consists of Main fields and Other fields, and 
can contain such information as the artist name, the album, etc. You can click the Change 
button to set a default tag for your recordings. You can override these defaults when you 
save a recording, however, changing a tag requires a full copy of the file. 

For more information, refer to the "Working with Ogg Vorbis Tag" section.



Using the Pre-recording Tab
The dialog looks like this:

Each of the configuration options is described below.

Maximum number of seconds to pre-record

You can specify the maximum number of seconds to be pre-recorded in the box to the right.

Activate pre-recording when the program starts

When this box is checked, pre-recording mode activates automatically when Total Recorder 
starts.

For more information on pre-recording mode, refer to the "Pre-recording mode overview" 
section.



Using the Debug Tab
The dialog looks like this:

Store trace information to file

Use this option only when advised by Technical Support. Selecting this option will result in 
additional overhead on your system.

Internal debug info

This box contains debug information that will help High Criteria’s Technical Support staff 
diagnose a problem. If you experience a problem with Total Recorder that requires Technical 
Support, you should take the following steps:

1. Use the "Copy all" button to copy the information to the Clipboard, immediately after the 
problem appears. The size of the data never exceeds 20 kilobytes.

2. You can then paste the information from the Clipboard into your correspondence with 
Technical Support.

It may be necessary for you to reproduce the problem in order to capture the debug 
information. 

If you need to contact Technical Support because a box appears with an error message, you 
can copy the internal debug information, as follows: 

1. Press the "Debug info>>" button in the error message box.

2. Use the Copy button to copy the debug information to the Clipboard.
3. You can then paste the information from the Clipboard into your correspondence with 

Technical Support.

Break detection



Use this option only when advised by Technical Support. Selecting this option will result in 
additional overhead on your system.



How to obtain a registration key

After installing and verifying the program works properly, you should obtain a registration 
key from High Criteria. If the program is unregistered then your recordings are limited to 40 
seconds each and you can use the scheduler only as an alarm.

Note: You cannot use your Version 1.x or 2.x registration key with Version 4.1. The 
registration key for Version 3.0 and later is valid for Version 4.1 (Standard Edition). The 
registration key for Version 4.0 is valid for Version 4.1 (Professional Edition). Registration 
keys for all previous versions of Developer Edition are not valid for Developer Edition Version
4.1.

To register Total Recorder:

1. Receive the registration key.

For registered users of versions 1.0 or 2.x Standard Edition and version 3.x 
Developer Edition. All registered users are entitled to a free registration key for the 
same edition. It is sent automatically by E-mail unless you specified that you do not want
to receive E-mails from High Criteria or you have not provided your E-mail address. If you
are a registered user wishing to upgrade, and you did not get your registration key, use 
the self-service registration key management system or contact support@HighCriteria.com.

OR

For new users and for registered users of Standard Edition wishing to upgrade 
to Professional Edition. Follow the instructions given on High Criteria Inc.'s web site at
the following address: http://www.highcriteria.com/products.htm.

To order by check, refer to the Registration.txt file in the installation folder of Total 
Recorder.

2. Select "Help" - "Registration". Type in the same name you used to obtain the registration 
key and type your registration key. Note that after registration this menu item is not 
accessible.



How to uninstall Total Recorder
To uninstall Total Recorder, use "Start"- "Settings"- "Control Panel" (for Windows XP use 
"Start"- "Control Panel"), "Add/Remove Programs". The Total Recorder driver remains in 
memory until you reboot.



Setting Recording Parameters
Before you begin recording, use the "Recording source and parameters" dialog to set your 
recording parameters. These parameters are saved for subsequent use. Changing 
parameters after a recording is finished affects only subsequent recordings. Total Recorder 
can convert already recorded sound when saving it.

When you schedule recordings using Total Recorder's built in scheduler, you can use 
different parameters for each job using the "Schedule Item" dialog.

Click the “Recording source and parameters” button, or from the “Options” menu, select 
“Recording source and parameters”. You are presented with the following dialog:

Recording source

Select one of the following (mutually exclusive) sound sources:

· Software – capture and record sound played back or requested by other computer 
programs. This feature is unique to Total Recorder and is not available from the vast 
majority of other sound recording programs.

· Sound board – record sound digitized by a sound card. This includes a microphone, CD 
or other input lines.

Additional parameters for source "Software"

If you select "Software", you can specify the following:

· Convert using “Recording parameters” specified below – convert the recorded 
sound to a format specified in the "Recording parameters" area. 

If this is not selected, the recorded sound will be in the original format (i.e. the format of 
sound being sent to the soundboard). If different parts of the sound have different 
formats then only the longest part will be recorded.

· Record also input stream (Internet telephony only) – capture and record input 



sound streams, requested by programs from the soundboard. This applies only to the 
recording of Internet telephony conversations.

· Put each speaker to a separate channel – special mode for Internet-telephony only. 
You can set this option only if you have selected the "Record also input stream" check 
box above. This creates a stereo file where one voice is in one channel and the other 
voice is in another channel. 

If “Put each speaker to a separate channel” is not set, the voices of both speakers are 
mixed in one channel.

Note: In version 3.0 and below, this mode was referred to as “Make Stereo”.

· Accelerate recording (silent mode) - the Total Recorder driver makes the playback 
program generate sound with a faster speed and suppresses the actual sound. Not all 
playback programs are compatible with this mode. For more information, refer to the 
"Accelerated Recording overview" section. If you select this option you must use the 
"Speed" pull-down menu to select the desired speed. 

· Speed: Max. – Total Recorder tries to make the playback program play at maximum 
speed. This is recommended for converting a sound file from a non-standard format to a 
standard format.

· Speed: a value – set a particular speed. Total Recorder tries to make the playback 
program play a specified number of times faster than normal. For example, you can set 
this speed to "4" to cause the playback program to play 4 times as fast as normal. This 
setting is recommended if the maximum speed is not possible (e.g. when recording from 
the Internet).

· Remove silence (prevent Internet transmission gaps) - Total Recorder tries to fix 
Internet transmission gaps. During the playback of an Internet transmission, failures of a 
short duration can occur. These are often due to an insufficient speed of data transfer 
and appear as pauses and replications during playback. When using some audio 
programs, such as Windows Media Player and Real Player, these pauses and replications 
can also appear in the recording. With the “Remove silence” mode turned on, Total 
Recorder removes pauses and replications from recording.

· Notes:

· This mode does not guarantee sound repair. The benefit you will see depends 
strongly on the characteristics of the gaps.

· It is very unlikely a recording will worsen when recording with this mode on.

· If you forget to turn this mode on before you start a recording, you can later play 
back the recording with one instance of Total Recorder and record the sound with 
another instance of Total Recorder that has the “Remove silence” mode turned on.
You can use accelerated recording mode in this case.

· The “Properties” part of Total Recorder  ’  s main window   displays the size of data 
without taking into account this mode. It displays the size of data passed to the 
soundboard. After a recording stops, the data size changes to reflect the size of 
actual data written to the file. If you see the data size become less after a 
recording has stopped, then some fixing of sound has taken place.

· Preserve pauses - If this mode is set, Total Recorder records silence even if nothing is 



being played back by any software, or playback is paused. This mode requires you to set 
"Convert using parameters specified below". You cannot use this option with the 
following: "Record also input stream", "Accelerate recording" and "Remove silence".

· Recording level: XX % of the original (100%) – Total Recorder increases or 
decreases the level of recorded sound relative to the level of the original sound. Use this 
setting to adjust the level of recording if you know in advance that the level of original 
sound is too low or too high. Unlike the normalization feature, the sound level is changed 
during the recording stage and is not restricted to PCM target format.

Additional parameters for source "Sound board"

If you select "Sound board", you can specify the following:

· Use current mixer settings – use current system settings. Normally, they can be 
viewed or changed from the standard mixer by double clicking on the "Volume Control" 
icon in the system tray.

· Use these lines of ... (the full name of this check box depends on the sound driver of 
the sound board) – points explicitly to lines that are switched on during recording. At 
least one line has to be specified. After a recording is finished, the original mixer settings 
are restored.

Using Different Settings

The following explains some different settings: 

· If you select "Software" as the Recording source and PCM is specified, the conversion 
algorithm depends on the value selected under the Algorithm Tab. See the "Using the 
Algorithm Tab" section.

· If you select "Software" as the Recording source and a compressed format is specified 
(non-PCM), the compression will be performed either with a selected codec or (for MP3 
only) with an external program. See the "Using the MP3 Tab" section.

· If you select "Sound board" as the Recording source and PCM is specified, no conversion 
is needed. The sound board will produce the required format.

· If you select "Sound board" as the Recording source and a compressed format is 
specified (non-PCM), the closest PCM format will be requested from a sound board and 
compressed. 

Any necessary conversions are normally done on the fly (i.e. as the recording is being 
made). If a conversion requires too much time and cannot complete during the recording, it 
will continue after the recording is finished. Refer to the "Long Operations" section.

Recording parameters

Use this section of the dialog box to set recording parameters. To change the format click 
the "Change" button. The "Sound format selection" dialog appears. For more details, refer to
Using the Sound format selection Dialog.

· Notes:

· For formats other than Ogg Vorbis: If a recording is performed over, appended to, or 
inserted into a previous recording or a file, then recording parameters are inherited 



from the sound format of the previous recording/file. 

· For Ogg Vorbis format: If a recording is performed over, appended to, or inserted into 
a previous recording, or a file, with Ogg Vorbis format, the results depend upon the 
bit rates, as shown below. 

Source File Parameters Actual Recording Parameters

VBR with bit rates xxx-yyy kbit/s VBR with bit rates xxx-yyy kbit/s

CBR with bit rate xxx kbit/s CBR with bit rate xxx kbit/s

ABR with bit rate xxx kbit/s and 
current recording parameters are ABR
with bit rate xxx kbit/s

ABR with bit rate xxx kbit/s

ABR with bit rate xxx kbit/s and 
current recording parameters are NOT
ABR with bit rate xxx kbit/s

Quality setting with quality that 
corresponds to bit rate of xxx 
kbit/s

The Total Recorder dialog overview

The Total Recorder dialog is made up of different parts, as shown below:

Main toolbar

This toolbar allows you easy access to common operations. You can use the following 
buttons:
Button Edition Description Menu Item Shortcut

All Create a new sound file File – New Ctrl+N
All Open an existing sound 

file
File – Open Ctrl+O

All Save an open file using 
the same file name

File – Save Ctrl+S

PE, DE Switch recording mode to 
append

Play/Record – Append
recording mode

None

PE, DE Switch recording mode to 
insert

Play/Record – Insert 
recording mode

None



All Undo previous operation Edit – Undo Ctrl+Z
All Redo the previously 

undone action
Edit – Redo Shift+Z

All Activate "Settings" dialog Options – Settings None
All Work with scheduled jobs Options – Schedule None
PE, DE Split current recording Play/Record – Split 

now
Ctrl+I

All Interrupt automatic work Play/Record – 
Interrupt work

None

Properties
This part of the dialog displays information about the current file being played or recorded. 
See Properties group description for details.
Status
This part of the dialog displays the current status of Total Recorder. See Status group 
description for details.

"Recording source and parameters" button

This button displays a dialog for the recording source and parameters. For more information 
on this dialog, refer to the Setting recording parameters.

During recording or pre-recording, you can use this dialog only to view recording 
parameters. Recording parameters must be set in advance.

Slider

In playing mode, the slider reflects which part of the sound file has been played back. You 
can move the slider backwards and forwards.

In recording mode, the slider position depends on the current recording mode - Overwrite, 
Append or Insert.

"Jump to time" button ( )

This button activates the “Jump to time” dialog. You can use this dialog to quickly navigate to
a position within a recording. For more information, refer to the “Jump to time dialog 
description” section.

To use this feature, you can also use the Ctrl+J shortcut or choose the “Play/Record” - “Jump 
to time…” menu item.

Position

This part of the dialog’s display depends on different modes, as described below:
Mode What is Displayed
Playing Current position in file
Recording with split mode off Slider position in current recording
Recording with split mode on Duration of current file

Main Buttons



You can use the following buttons:

Button Edition Description Menu Item Shortcut
All Rewind to the 

beginning
Play/Record – To 
Start

None

All Left (one step) Play/Record – Left 
by nn.n sec.

Ctrl+L

All Right (one step) Play/Record – Right 
by nn.n sec.

Ctrl+T

All Fast forward to the
end

Play/Record – To 
End

None

All Play Play/Record – Play Ctrl+Y
All Pause/Continue Play/Record – 

Pause/Continue
Ctrl+U

All Stop Play/Record – Stop Ctrl+P
All Record Play/Record – 

Record
Ctrl+R

Between the  and 

 buttons is a list for selecting the step that these buttons use to position your recording. 
The step is specified in units of time, ranging from 1/10 of a second (0.1s) to 15 minutes 
(15m). To quickly decrease or increase the step, you can use the Ctrl+< or Ctrl+> shortcuts,
respectively.



Properties group description
This part of the Total Recorder dialog displays information about the current file being played
or recorded. For example:

MPEG Layer-3 – format name.

320kBit/s; 48,000Hz; Stereo – format parameters.
The line below these format parameters is normally empty but may contain a message such 
as "xx.x sec. of other formats lost". This message appears only in Software mode and only 
when the output format is not specified. If this is the case, and the recorded sound contains 
several fragments with different characteristics, only the longest fragment is kept and all 
others are lost.

Data size, bytes – size of recorded data in the recording/playing file. This does not include 
the length of the non-data part. You can display the full length by selecting “File”, 
“Properties”.

Duration - playback time in seconds.
In split mode:

· The "Data size, bytes" field is renamed to "Tot. data size, bytes". 

· The "Tot. data size, bytes" and "Duration" fields display information about the total size 
and time (from start of recording), rather than the size and duration of the current file.

In xx%, Out xx%, Both xx%, Fail xx% - this information appears only when you record. 
The display varies depending on the recording activity.

Recording Activity Display
Sound being played back Out 100%
Internet telephone conversation in 
full-duplex mode

Both 100%, since sound is transmitted 
back and forth simultaneously

Internet telephone conversation in 
half-duplex mode

In - % of time the user of the given 
computer talked
Out - % of time the remote partner talked

From microphone, CD or other input
line

In 100%

Internet telephone conversation in 
full-duplex mode, different format 
for input and output sounds 

Fail 100%

Note: This data relates only to the last recording session and not to the entire file.



Status group description

This part of the dialog displays the current status of Total Recorder. The possible values are: 
“Playing”, “Paused Playing”, “Recording”, “Paused Recording”, “Auto playing until hh:mm:ss”, 
and “Auto recording until hh:mm:ss”. Values can include information related to pre-
recording.

Some further explanations follow.
“Auto” - recording or playback was started by the scheduler or from the command line, or 
auto stop is on. The time (hh:mm:ss) is the time that the job will complete. You cannot 
control the job other than cancel it by clicking on the “  button on the Main toolbar, or by 
selecting “Interrupt work” from the “Play/Record” menu. Other controls, such as “Pause” are 
disabled. You can cancel Auto stop by selecting “Play/Record”-“Auto stop recording”.
xx.x sec. pre-recorded - indicates the number of pre-recorded seconds. This number is 
limited by the value you specify in the “Pre-recording parameters” dialog. This information is 
displayed only if pre-recording mode is on.

Clock icon - indicates that a scheduled job is currently in progress, or Auto Stop is on. It 
does not relate to the fact that some jobs are scheduled.

Level indicators - reflect the amplitude of the signal for the left and right channels during 
recording and playback. When recording from “Software” the “reactivity” depends on the 
size of the playback program's internal buffer. For some programs this can be changed once 
per second or even more often.

Level percent - reflects the maximum amplitude of the signal for the left and right 
channels during the previous second of recording or playback. Professional Edition users can
use values obtained during test recordings to set parameters for split mode recording based 
on the level of sound.



Jump to time dialog

This dialog can be activated by clicking the “Jump to time” button ( ), using the Ctrl+J 
shortcut, or with the “Play/Record” - “Jump to time…” menu item. You can use this dialog to 
quickly position within a recording.

To jump to a position:
1. Specify the position using either the HH:MM:SS.d field or set values in the hr. (hours), min.
(minutes), sec. (seconds), and 1/10th sec. (10ths of seconds) fields.
2. Click the Jump button.



Using the Selection Panel

The Selection panel lets you select a fragment of sound data and perform one of the 
following operations:

· save it to a file

· delete it

· copy it to the Clipboard

· other operations, as described below.

The Selection panel below the slider is not visible by default in the Standard Edition. Select 
“View”, “Show selection” from the menu to turn on/off the Selection panel.

Here is the main dialog with the Selection panel displayed:

The following are some characteristics of the Selection panel:

· The buttons that control each selection boundary show the position in seconds.

· The current position of each selection boundary is controlled by a different group of 
buttons. You can position selection boundaries with 0.1-second accuracy.

Selection Panel Buttons

You can use the following buttons on the Selection panel:
Button Editio

n
Description Menu Item Shortcut

All Set left selection 
boundary to current slider 
position

Edit – Selection – 
Set beginning of 
selection

Shift+L

All Move current position of 
slider to left selection 
boundary

Edit – Selection – Go
to beginning of 
selection

L



All Toggle selection off Edit – Selection – 
Toggle selection off

Ctrl+Shift+C

All Move current position of 
slider to right selection 
boundary

Edit – Selection – Go
to end of selection

R

All Set right selection 
boundary to current slider 
position

Edit – Selection – 
Set end of selection

Shift+R

All Precise positioning of 
selection boundaries. The 
selection boundary moves
0.1 second left and right. 
The main slider’s position 
does not change.

Edit – Selection – 
Shift beginning/end 
of selection 
left/right by 0.1s

Shift+M
Shift+N
Shift+S
Shift+T

PE, DE Delete selection and place
it on Clipboard

Edit – Cut Ctrl+X

PE, DE Copy selection to 
Clipboard

Edit – Copy Ctrl+C

PE, DE Paste data from Clipboard 
to current recording

Edit – Paste Ctrl+V

PE, DE Delete selection Edit – Delete 
selection

Delete

PE, DE Delete data except what 
is selected

Edit – Delete except
selection

Ctrl+Delete

All Save selection to specified
file

File – Save selection
as…

None

All Stop playing at nearest 
selection boundary

Edit – Stop playing 
at selection 
boundary

P

To select the entire sound data, select "Edit"–"Selection"–"Select All" or press Ctrl+A.

For more information on using the Selection panel for editing sound data, refer to the 
"Editing a Sound File" section.

Length

This part of the Selection panel displays the length (in seconds) of the current selection.



Working with Sound Images (Professional and Developer Editions Only)

The Sound Image panel provides a visual representation of the characteristics of sound data.
This panel can be activated/deactivated using the “View”->Show sound image” menu item.

Here is the main dialog with the Sound Image panel displayed:

The Sound Image panel has two images: a small-scale image (at the top) and a large-scale 
image (at the bottom).

Small-scale image

This image represents the entire sound data. The graduation scale depends upon the 
amount of sound data. A red, vertical line shows the current position. A green point 
represents the level of sound at that point. You can click on any point in the image to 
navigate to the corresponding position in the sound file. 

Large-scale image

This image uses a larger scale (i.e. each line represents 1 second), and shows sound data to 
the left and right of the current position. A red, vertical line is always located at the center of
the image. A green point represents the level of sound at that point. You can click on any 
point in the image to navigate to the corresponding position in the sound file.

Using the Sound Image panel

You can use the Sound Image panel to locate bits of silence between songs. On the small-
scale image, these parts will be represented with green points that are close to the zero 
level. Click somewhere within this group of points. You can adjust the current position using 
the large-scale image below. As you move your mouse cursor over an image, the 
corresponding position in the recording appears to the right.

Note: It is recommended you display this panel only when necessary. If you work with the 
Sound Image panel displayed, then opening a file, or editing a recording, causes the sound 
image to be recalculated, and could take a long time. 



Recording overview
In order to record all of the sound generated from a software program, you should start the 
recording before starting the playback's program. Every playback program sends 
information to a driver with some delay, usually several seconds. If you start recording when
sound has already played back, it will look as if nothing happens for several seconds and 
then the indicators will show the real beginning of the recording.

For information on using the built-in scheduler or command line to schedule a recording, 
refer to the section "Using a Scheduler overview".

For information on recording using "Software accelerated recording/converting", refer to the 
section "Accelerated Recording overview".

For information on using pre-recording mode, refer to the section "Pre-recording mode 
overview".



Starting Recording
Before you begin recording, set your recording source and other parameters if these have 
not been set as you require. Click the "Recording source and parameters" button or select 
"Recording source and parameters" from the "Options" menu. Refer to    "Setting Recording 
Parameters". 

To start recording, either click the "Record" button ( ), select Record from the "Play/Record"
menu, or press Ctrl-R. 
As soon as your recording starts, the message "You have unsaved data!" appears under the 
"Record" button. This is to remind you that data is being written to a temporary file. If you 
want to store the output permanently, you must save the data once your recording is 
complete. 
If you try to make a new recording before saving the previous one, the result depends on the
"Action on new recording over the previous one" setting and the recording mode (Append or 
Insert). For more information, refer to the "Using the Open/Save Tab".
If "Software" is selected as a source, a sound is recorded only when some program 
reproduces or requests it. After starting the "Record" feature, the corresponding indicator on 
the "Status" panel becomes highlighted. This indicates Total Recorder is ready to record but 
the real recording process does not start until Total Recorder receives some sound from 
another program. If the level indicators do not become green, there is no data to record.

If "Sound board" is selected as a source, the recording size remains at zero until sound data, 
that is not absolute silence, is received from the soundboard. The level indicators reflect 
this. When such sound data is received, the silence is included in the recording and reflected
in the recording size displayed. If no source sends real sound to the soundboard, Total 
Recorder may receive non-silent sound from a particular soundboard line based on the 
following:

· soundboard characteristics

· level of recording

· type of input line. For example, non-silent sound will more likely be received from a 
microphone line than from "line-in",

· sound format parameters. For example, it is very likely that non-silent sound will be 
received in the case of 16-bit sound format but not in the case of 8-bit sound format.



Interrupting a Recording
To temporarily interrupt recording, either use the "Pause/Continue" button ( ), select 
"Pause" from the "Play/Record" menu, or use Ctrl-U. To continue a paused recording, either 
use the "Pause/Continue" button again, select "Continue" from the "Play/Record" menu, or 
use Ctrl-U.

If "Software" is selected as a source, all information during a pause will be written to a 
temporary file. This allows a recording to continue immediately after the pause is finished. 
Remaining in "pause" for a long time may take a lot of your hard disk space and is therefore 
not recommended.



Stopping a Recording
To stop recording, use the "Stop" button ( ), select "Stop" from the "Play/Record" menu, or 
use Ctrl-P. 

You can use the "Undo" ( ) and "Redo" (
) buttons to undo and redo your last recording.



Saving a Recording
To save a recorded sound stream to a file, use "Save" or "Save As" on the "File" menu, or 
press Ctrl-S. The file is saved as a .wav, a .mp3 or a .ogg file.
If you save over an existing file, the resultant file format is:

· the same format of the source file, if you use “Save”

· the specified format, if you use “Save As”.

A recording is not considered saved unless it was saved in full. This affects the actions taken 
when you are about to overwrite a recording.
If your recording was performed in split mode, the recording is saved immediately after it 
has stopped.

Saving Part of a Recording

You can also select and save only part of a recording by taking the following steps:

1. Make the Selection panel visible. If it is not visible, select “View”, “Show selection” from 
the menu.

2. Select the left and right boundaries by moving the slider and marking the left and right 
selection boundaries. For more information, refer to the "Using the Selection Panel" 
section earlier in this document. You can set selection boundaries during recording and 
then slightly reposition them. You cannot set selection boundaries when recording in split
mode.

3. Save your selection. Use the ( ) button in the Selection group, or select “File”, “Save 
selection as” from the menu.

Saving Multiple Recording Fragments
You can save multiple recording fragments as different files. The size of a .wav file cannot 
exceed 4GB. This is an internal limitation of the WAVE format. If the size of your recording is 
greater than 4GB, you can either divide it into smaller parts or convert it to a lower quality. 

Saving a Recording in a Different Format

You can save your recording in a format different from the original, however it may take a 
significant amount of time.

To change the format, take the following steps:

1. Choose the "Save As" dialog.



2. Click "Change" and select a format. For more information, refer to the "Using the Sound 
format selection Dialog" section.

3. If you select MP3 or Ogg Vorbis format, you can click "More" and change the default file 
type and ID3 tags for MP3 and tag for Ogg Vorbis. For more information, see the "Using 
the MP3 properties Dialog” and ”Working with Ogg Vorbis tag” sections. Changing a file 
type requires a full file copy but deleting, adding or editing the ID3v1 tag does not. 
Adding or removing the ID3v2 tag requires a full file copy; editing the ID3v2 tag may 
require a full file copy. Adding, removing, or editing an Ogg Vorbis tag requires a full file 
copy.

4. Enter the name of the new file, if you haven't already done so. The default extension 
is .wav, .mp3 or .ogg depending on the selected format. You cannot manually specify an 
extension.

5. Click "Save" to save your recording.



Using Fast Save
Beginning with Version 3.0, Total Recorder writes a ready-to-use wav or mp3 file without 
saving an intermediate working file. A save operation usually just renames (moves) the 
working file and is almost instantaneous regardless of the file size. However, the following 
situations will prevent this and require copying of the entire file.
· The file is being saved to a different drive, either physical or logical, than the drive that 

stores the working file. Use "Options"- "Settings", "Open/save" tab to change the location
of the working file.

· The file format changes.
· The header type changes from RIFF-WAV to MP3 or vice versa.

· The file is being normalized.
· The existing file was appended with new data, new data was inserted, or the file was 

edited.
· Adding or removing the ID3v2 tag. Editing the ID3v2 tag may require a full file copy.

· Adding, removing, or editing an Ogg Vorbis tag requires a full file copy.

Note that changing the ID3v1 tag does not prevent a fast save operation.



Using Auto Stop Mode

When Total Recorder is recording, you can specify time when the recording will stop. You can set or reset 
the auto stop mode by selecting "Auto stop recording" from the "Play/Record" menu. The following dialog 
appears:

Stop recording at – when this box is checked, Auto Stop is on. You can then use the fields to the right to 
specify a time:

Time (hours, minutes, seconds) – set the time to stop the recording.

Now – display the current time. This is useful when you want to use a relative time such as 5 
minutes from now.

Advanced (Professional and Developer Editions only) – activates the "Advanced stop 
recording conditions" dialog. Here you can set additional options for automatically stopping a 
recording. For more information, refer to "Using the Advanced stop recording conditions Dialog" 
section.

Save recording to file – the file name where the recording will be saved. This field is mandatory except 
for recordings in split mode. If recording is in split mode, the field is disabled and the file name is 
automatically generated based on your file name generation rules (see the "Specifying File Name 
Generation Rules" section).

Normalize to – check this box to normalize before saving, and then use the box to the right to specify a 
percentage. This is enabled only for PCM format. For more information, see Normalizing a Sound File. 
Normalization is not possible if split mode is on.

Quit Total Recorder after job completes – Total Recorder will close after the recording stops.

When auto stop is active, all other controls are disabled. The behavior is similar to that of a scheduled job 
(see Actions you can take during a Scheduled Job). The only difference is that you can cancel the auto 
stop by selecting "Play/Record" - "Auto stop recording" again, and turning off the “Stop recording at” box 
so that the recording will continue in regular mode. Any error messages are not displayed but are written 
to the Total Recorder Log (see Handling Errors and Other Problems).



Accelerated Recording overview
Software accelerated recording (silent mode) lets you convert sound files of different formats
to standard wave format. This is normally done at a fraction of the time required to play the 
file. Total Recorder suppresses playback, makes the sound stream go through the driver with
an above normal speed, and records it.

The playback program switches to a different mode only when the new sound stream starts. 
When using accelerated mode you must switch on record first and then start playing the 
sound back.

You cannot use accelerated recording mode and pre-recording mode at the same time.

When using accelerated mode you cannot hear any sound but the slider of the playback 
program moves faster than normal. Total Recorder also shows the recording moves by the 
following:

· the indicator of the current position moves faster than normal 
· the level indicators change from being empty to green.



Accelerated Recording compatibility
Since the playback program has to work faster than was intended, some programs are not 
compatible with this mode. They will either work with normal speed or some error may occur
(e.g. some fragments may be lost or repeated more than once, or some extra pauses or 
noises may be inserted). Different versions of the same program may behave differently. 

This document does not provide a list of compatible and incompatible programs. The simpler
the playback program the more likely it will work correctly in accelerated mode. Programs 
that synchronize sound with some other events such as games or video players will not 
likely work in accelerated mode.

The maximum possible speed may also vary. This usually depends on some internal 
parameters of a playback program, which are not documented and are not configurable, 
because normally they do not matter.    

Through experimentation, you can determine both the compatibility of a particular program 
with accelerated mode and the optimal speed. Make your recording then listen to it. If there 
is no problem, or a problem that can be easily corrected with a selective save, you may use 
the accelerated mode. Otherwise, you can lower the speed. If this doesn't help you can 
either use regular recording or change your playback program. 

If a program plays a sound from a hard disk or a local area network and it allows accelerated
mode, it will probably allow maximum speed. However, there are some exceptions. If the 
program plays a sound from the Internet, it is usually impossible because the sound driver 
will request the information faster than the connection supplies. In this case, you can 
manually adjust the speed based on the available bandwidth. If the connection is either very
slow or bad, try to set the speed below normal. 



Pre-recording mode overview

Sometimes when listening to an audio program (e.g. Internet transmission), you do not know
exactly when to start recording. With previous versions of Total Recorder, you could either 
record sound continuously or start your recording when you hear the part in which you are 
interested. Each case has its own problems. Either you would likely end up with a large file, 
where you would need to remove large amounts of unwanted sound, or you would miss 
essential data.

Using Total Recorder’s pre-recording mode, a pre-specified amount of sound is stored 
internally. When you start your actual recording, the pre-recorded sound is added to the 
beginning of your recording and the storing of information in an internal buffer stops. If you 
were to start and stop a recording multiple times, where the number of seconds stopped 
each time is less than your specified pre-recording time, then your resultant recording will be
the same as that obtained by an ordinary uninterrupted recording (see concerns when 
appending to a recording).

For more information on using pre-recording mode, refer to the "Using Pre-recording Mode".

Note:
You cannot use pre-recording when “Accelerated recording” mode is on. For more 
information on “Accelerated recording” mode, refer to the "Accelerated Recording overview" 
section.



Using Pre-recording Mode

To set pre-recording parameters, use "Options"- "Settings", "Pre-recording" tab. For more 
information, see "Using the Pre-recording Tab" section.

To turn pre-recording mode on or off, use the "Pre-recording xxx last seconds" menu item 
from the "Play/Record" menu. You can also use the Ctrl+G shortcut. The actual number of 
seconds specified on the "Pre-recording" tab is displayed in the menu item name.

To clear the pre-recording buffer, use the "Clear pre-recording buffer" menu item from the 
"Play/Record" menu. You can also use the Ctrl+B shortcut. You may want to clear the pre-
recording buffer if you do not wish to include pre-recorded sound in your recording. The pre-
recording buffer can be cleared if it is not empty.

If Total Recorder starts to perform a scheduled job or starts with command line parameters, 
pre-recording mode will not be turned on at program start regardless of the "Activate pre-
recording when the program starts" setting.

When pre-recording mode is on, the following takes place:

· a message appears in the “Status” part of Total Recorder  ’  s main window   that indicates 
the number of actual pre-recorded seconds (e.g. “xx.x sec. pre-recorded”).

· the record notification picture  changes to 
, if there is no actual recording.

· the “ Pre-recording xxx last seconds” menu item changes.
· the level indicators display the level of pre-recorded sound.
For pre-recording mode overview, refer to the section "Pre-recording mode overview".

Caution:
Pre-recording uses computer hardware resources. This mode should only be used when 
necessary.

Note:
When you record and pre-record using compressed (non-PCM) format, a gap may appear in 
your recording at the point when you switch from recording mode to pre-recording mode.



Editing a Sound File

The Professional and Developer Editions of Total Recorder have built-in sound editing 
capabilities. For more information on working with the Selection panel, see "Using the 
Selection Panel".

Using the Clipboard (Professional and Developer Editions only)

Total Recorder supports standard Windows Clipboard functionality. You can copy, cut and 
paste fragments of a recording within Total Recorder and between Total Recorder and other 
applications that support the Windows Clipboard.

Copying a Fragment

To copy a fragment:

1. Select the fragment.

2. Click the  button, or select "Edit" – "Copy" on the Selection panel.

Cutting a Fragment

To cut a fragment:

1. Select the fragment.

2. Click the  button, or select "Edit" – "Cut" on the Selection panel.

Pasting a Fragment

To paste a fragment from the Clipboard:

1. Use the Slider to set the current position.

2. Click the  button on the Selection panel, or select "Edit" – "Paste".

If the parameters of a fragment are different from the parameters of the current sound data,
the fragment is converted using the parameters of the current sound data.

Saving a Fragment to a File

You can save part of your recording as a separate file by taking the following steps: 

1. Select the desired fragment.

2. Click the  button on the Selection panel.

3. Choose a file name using the standard "Save As" dialog.

Inserting a Sound File (Professional and Developer Editions only)

You can insert a sound file anywhere in your recording by taking the following steps: 

1. Use the Slider to set the current position.



2. From the "Edit" menu, select "Insert a File at Current Position".

3. Choose the file name using the standard dialog.

If the parameters of an inserted file are different from the parameters of the open file, the 
inserted fragment is converted using the parameters of the open file.

Deleting a Fragment (Professional and Developer Editions only)

You can delete part of your recording by taking the following steps:

1. Select the desired fragment.

2. Click the  button on the Selection panel.

Deleting Data Except for a Fragment (Professional and Developer Editions only)

You can delete parts of your recording except for a selected fragment by taking the following
steps:

1. Select the fragment you want to keep.

2. Click the  button on the Selection panel. All data is deleted except for the fragment.

Undoing the Previous Operation 

To undo an operation, click the  button on the main toolbar. Note that you cannot undo an 
operation once a file is saved. 

The Redo  button on the Main toolbar reverses Undo.

The Undo buffer stores all selection operations (e.g. set beginning of selection), 
normalization operations, recording operations, and editing operations. The Undo buffer is 
cleared after saving the current file.

The Undo and Redo actions for the Standard Edition apply only to the operations that are 
available in the Standard Edition.



Playing a Sound File
To play a sound file, click the "Play" button ( ), select "Play" from the "Play/Record" menu, 
or press Ctrl-Y. Total Recorder starts to play the recording from the current position or from 
the beginning if the current position is set to the end of the file.

For information on using the built-in scheduler or command line to schedule a playback, 
refer to the section "Using a Scheduler overview".

Pausing the Playback

To interrupt the playing of a sound file, click the "Pause/Continue" button ( ), select "Pause"
from the "Play/Record" menu, or press Ctrl-U. To resume a paused playing, click the 
"Pause/Continue" button, select "Continue" from the "Play/Record" menu, or press Ctrl-U.

Moving Within a File

You can use the slider to move forward or backward in a sound file. You can also use the 
rewind button  to go to the beginning and the rewind button 

 to go to the end. Additionally, you can move right or left with a fixed step using the 
 and 
 buttons or their keyboard equivalents (Ctrl-L - left, Ctrl-T - right). There is a drop-down list 

for selecting the step between the 
and
buttons.

Stopping

To stop playing, use the “Stop” button ( ), select “Stop” from the “Play/Record” menu, or 
use Ctrl-P.

Playing a Selection

You can play a selection by selecting “Play selection” from the “Play/Record” menu or by 
using Ctrl-E.

See also: Working With Sound Image (Professional and Developer Editions Only)



Normalizing a Sound File
Normalizing is a process of increasing the sound level (loudness) so that the amplitude of 
the loudest parts is close to the maximum allowed for a given sound format. Because it also 
increases the level of noise, normalizing should only be used if there is no other way to 
adjust the volume. For example, you should not use normalizing with Sound Board mode 
recording because you can always adjust the level using a mixer.

Only a non-compressed file (PCM format) can be normalized. 

To normalize a sound file, take the following steps:

1. Select "Volume"- "Normalize" from the main menu. The    "Normalization" dialog appears, 
as shown below.

2. Select the level of normalization in percentage. The default is 100%. If you plan to later 
transform your sound file (to compress it, for example), it is recommended you set this 
value to 80-90% to avoid overflowing. 

3. Click "OK".

The normalization process is fully reversible. You can set any value and go back to the 
original.

In rare cases, you may need to set the normalization percentage greater than 100. For 
example, you can improve a recording if the average level is low but there are a couple of 
peaks (e.g. noise).

After edit/recording operations the normalization value is discarded.

You can use the "Undo" ( ) and "Redo" (
) buttons to undo and redo the last normalization.



Long Operations
The following operations may take a significant amount of time:

· Saving a file, if fast saving is not possible.
· Inserting from a file or the Clipboard.

· Finishing "on the fly" conversion, if it was not possible in real time.
· Calculating the maximum amplitude for normalization.

· Calculating the sound image.

A dialog, similar to the following, appears during long operations: 

Stopping a Long Operation

To stop an operation, click "Cancel" and reply to the confirmation. The result depends on the 
operation:

· Saving a file – stops and erases the part of the file that has already been written.

· Converting format – stops and the converted part of the file is saved.

· Normalization – the Normalization dialog is hidden.

· Calculating the sound image – the Sound Image panel is hidden.



Working with MP3 Format
Total Recorder does not have a built-in compression/decompression engine for any sound 
format, including MP3. Total Recorder can only play and record a compressed file if the 
appropriate audio codecs are installed.

Using Codecs

An audio codec is a special program (driver) that converts sound formats. When a codec is 
registered (installed) it can be used by any audio processing application. Each version of 
Windows includes a basic set of codecs. Users can also download, or buy and install, 
additional codecs. Starting with version 3.0, Total Recorder can use codecs installed in your 
system.

There are different types of codecs that support MP3. A simple codec can only decode MP3 
and is sufficient for playing MP3 files. However, to create an MP3 file you need a codec that 
supports encoding. A codec that only supports encoding for low bit rates is included in some 
versions of Windows (e.g. Windows 98 and Windows ME). This is sufficient for recording radio
broadcasts but not for CD-quality music. You can buy codecs that support higher bit rates.

Using DLLs

Total Recorder can also use a DLL (dynamic link library) dedicated to MP3, either 
BladeEnc.dll or Lame_Enc.dll. Unlike codecs, neither one of these DLLs can decode an MP3 
file, which means that Total Recorder may be able to record but not play MP3 files. If you use
one of these DLLs, it is recommended that you also install a decoding-only codec to enable 
both playing and recording of MP3 files.

Selecting an MP3 Encoder

MP3 encoders, including codecs, BladeEnc.dll, and Lame_Enc.dll, differ in price, speed and 
quality. Select the one you find most suitable.

Types of MP3 Format

Total Recorder can play and record MP3 files in either WAV or MP3 format. The difference is 
in the file header.

WAV-format files have a standard RIFF-WAVE header. These files usually have a .wav 
extension. As long as an appropriate codec is installed and recognized, any playback 
program can play them.

Pure MP3-format files do not contain any special headers but may contain an ID3 tag. These 
files usually have a .mp3 extension. To play this type of file, you need a program that can 
decode MP3 format.

Setting MP3 Parameters

You set parameters relating to MP3 on the "MP3" tab of the configuration dialog. For more 
information, see Using the MP3 Tab.



Using the MP3 properties Dialog
Total Recorder lets you record MP3 files as WAV-MP3 files, with a standard RIFF-WAVE header,
or "pure" MP3 files. For pure MP3 files, you can also create ID3 tags (ID3v1, ID3v2, or both) 
that contain information about the audio file.

You can invoke this dialog from different places. If you invoke it from the configuration dialog
or saving dialog, you can change the File header type. If you invoke it from the "Tag" field of 
the "File" menu, only part of this dialog appears. 

The "Tag" menu item is enabled for "pure" MP3 files only.

Note: The ID3v1 tag is completely supported. Only Version 2.3 and below of the ID3v2 tag is
supported. An error message is issued if the file being opened has an unsupported version of
the ID3v2 tag, the tag is not correct, or the tag cannot be read by Total Recorder for some 
other reason. In such cases, the only operation allowed is deletion.



Working with Ogg Vorbis Format
Total Recorder supports the Ogg Vorbis format by using an external dynamic link library 
named vorbishc.dll. You can obtain this library, free of charge, through High Criteria’s web 
site. To add support for Ogg Vorbis to Total Recorder, or to review new versions of 
vorbishc.dll, go to the http://www.highcriteria.com/tr_ext_res.htm link and follow the instructions.

Setting Ogg Vorbis Parameters

You set parameters relating to Ogg Vorbis on the "Ogg Vorbis" tab of the configuration 
dialog. For more information, see Using the Ogg Vorbis Tab.



Working with Ogg Vorbis tag
For an Ogg Vorbis file, you can create a tag that contains information about the audio file. A 
tag can contain many different fields. The dialog for adding, removing, and editing a tag 
looks like this:

This dialog can be invoked from different places. The dialog contains two parts: 
· Main fields - includes fields that are considered significant
· Other fields – fields that are considered less significant. These can include any arbitrary

tags. 
There are three buttons you can use to work with these “Other fields”. 
· Add – add new field
· Edit – edit existing field 
· Delete – delete field.
When you use the “Add” or “Edit” button, the following dialog appears. 

Use this dialog to assign a Name and Value to the field.



Using the Sound format selection Dialog
The dialog looks like this:

Each of the fields is described below.

Name – list of named formats. You can select any format from the list. There are some 
system-named formats and you can name any format and save it for future use.

Save As – assign a name to the format and its attributes so it will appear in the "Name" list 
above.

Remove – remove a named format. Note that you cannot delete a system-named format.

Format – list of format types.

Notes:

· To record in MP3 format, you must have a fully functional codec (i.e. one that can encode
and decode) or a special program. For more information, refer to the "Working with MP3 
format" and "Using the MP3 Tab" sections.

· To record in Ogg Vorbis format, you must have the vorbishc.dll library. For more 
information, refer to the "Working with Ogg Vorbis format" and "Using the Ogg Vorbis 
Tab" sections.

Attributes – list of format parameters. This field is available for all formats except Ogg 
Vorbis.

Encoding properties– this group is for encoding in Ogg Vorbis format.

Sample rate – encoding sample rate.

Mode – Mono or Stereo

Choose one of the encoding methods below. You can either select a method based on



quality (Use quality management) or based on the bit rate (variable, average, or 
constant).

Use quality management – sets a desired level of quality. This is the recommended
setting. The approximate bit rate for the selected quality is shown to the right.

Variable bit    rate – sets minimum and maximum bit rate boundaries for encoding. 
Data is encoded with various bit rates within these bounds.

Average bit rate – sets nominal bit rate for encoding. Data is encoded with various 
bit rates keeping to the nominal bit rate.

Constant bit rate – sets nominal bitrate for encoding. Data is encoded with a 
constant bit rate.



Displaying File and Recording Properties
You can display properties of a file and of a recording by selecting "File", "Properties". The 
following dialog appears:

Type – header type.

RIFF-WAVE – standard header. This type of file normally has a WAV extension.

MP3 – no header. This applies only for MPEG Layer 3 (MP3) files. This type of file 
normally has an MP3 extension.

Ogg Vorbis –This applies only for Ogg Vorbis files. This type of file has an OGG 
extension.

Format – format description. This indicates the format type (PCM – main, non-compressed 
format; all other formats are compressed) and format characteristics (e.g. frequency, 
number of channels, and other format–dependent parameters).

Saved sound data – this group relates to a disk file (i.e. the last saved version).

Date, time – date and time of the last modification.

File size – full size of file.

Data size – size of data in the file. This excludes headers and tags.

Play time – play time. This is an approximate time only and the accuracy depends on 
the compression and the particular codec. 

Average bit rate – average bit rate, in kbit/s. This value indicates a degree of 
compression. A lower value corresponds to a higher level of compression.

Current sound data – this group relates to the current recording, which can contain both 
saved and unsaved data.

Data size – size of data in the file. This excludes headers and tags.

Play time – play time. This is an approximate time only and the accuracy depends on 
the compression and the particular codec. 



Average bit rate – average bit rate, in kbit/s. This value indicates a degree of 
compression. A lower value corresponds to a higher level of compression.

Note: If you display the properties for Ogg Vorbis sound data, then additional information 
appears for each logical bitstream.



Using the Advanced stop recording conditions Dialog (Professional and Developer 
Editions only)

The "Advanced stop recording conditions" dialog is available from the “Auto stop recording” 
dialog (see "Using Auto Stop Mode") and the "Schedule item" dialog (see "Scheduling a 
Job"). This dialog lets you specify conditions under which a recording will stop.

Stop time – the time to stop auto recording. This time reflects the Stop time setting in an 
upper-level dialog. Changing this time results in a change in the upper-level dialog and vice 
versa.
Recording duration – the time limit for recording. The value of duration is calculated on 
the basis of the start and stop times of the recording.

"Stop time" and "Recording duration" are related. Changing the value of one field causes 
change to the other. If recording is performed in split mode, the duration is the time limit for 
all the files that have been recorded.

Approx. size – displays the approximate size of the recording that has specified duration. If 
the recording format is unknown, then the field displays "Unknown".

Limit recording to – the size limit of the recording. If recording is performed in split mode, 
the limit is for all the files that have been recorded.

Approx. time – displays approximate duration of the recording that has specified size. If the
recording format is unknown, then the field displays "Unknown".

Stop recording if nothing recorded in nnn sec. - if this option is enabled, recording will 
be stopped if nothing is recorded during a nnn-second period. Setting this option can be 
useful, for example, if you do not want the recording of an Internet transmission to continue 
after the Internet transmission has finished, or your connection to the Internet has been lost.

Stop recording if sound level does not exceed mmm % in nnn seconds. 
Do not stop recording if less than kkk seconds has been recorded. - if this option is 
enabled, recording will be stopped if the recording level during an nnn-second interval is 
less than mmm % of the maximum sound level. This setting can be useful, for example, if 
you want to stop recording after a radio transmission ends and the Internet radio station 
transmits low-level noise. Or, for example, if you record from an audio cassette and want the
recording to stop when the cassette ends. Setting the value of kkk seconds can help prevent
a recording from stopping immediately (for example, if there is a delay when starting to play



an audio cassette).

Shut down computer after the job completes - if this option is enabled, your computer 
will be shut down after the job completes.



Specifying File Name Generation Rules (Professional and Developer Editions only)

You can use file name generation rules during a regular recording in split mode, and during a
scheduled recording if the "Auto create file name" option is set. File name generation rules 
for a regular recording and for a scheduled recording are independent.

Take the following steps to display and set file name generation rules.

For a regular recording:

1. On the "Settings"-"Split" tab, press the "Rules..." button.
2. Set the required options on the "File name generation rules" dialog.

For recording during a scheduled job:

1. Select "Auto create file name" on the "Scheduled Item" dialog (see "Scheduling a Job" 
section).

2. Press the "Rules..." button.

3. Set the required options on the "File name generation rules" dialog.

Using the File name generation rules Dialog

The "File name generation rules" dialog looks like this:

A generated file name has the format: "Base file name" + "sequential number" + "creation 
date" + "creation time". Each part is optional.

For example, in the file name TR_Rec_001-020608-195053940:

· TR_Rec_ is the Base file name

· 001 is the sequential number (3 digits)

· 020608 is the creation date (June 8, 2002)

· 195053940 is the creation time (19:50:53:940).

Base file name – enter a prefix if you wish to have a prefix included in the file name. You 
can use both a file prefix without a path and a file prefix with a path (full or relative). If a full 
path is not specified, the current default directory is used (see "Configuring Total Recorder"   –  



"Using the Open/save Tab").

sequential number … digits – select this option to include a sequential number in the file 
name. You can specify the number of digits in the sequential number using the “digits” field.

creation date – select this option to include the creation date in the file name. You can 
choose the date format: YYMMDD or YYYYMMDD.

creation time – select this option to include the creation time in the file name. You can 
choose a time format: HHMMSS or HHMMSSmmm.

Default Names in Split Mode

File name generation rules always apply in split mode. There are default rules for generating
the names and you can choose to change these rules. The default rules are: 

· Base name = “TR”

· Include sequential number = “No”

· Include creation date = “Yes” in YYYYMMDD format

· Include creation time = “Yes” in HHMMSS format.    

For example, TR20020529-173508.wav represents a file created on May 29, 2002 at 
17:35:08.



Split mode overview (Professional and Developer Editions only)

Setting split mode causes a new file to be created for each recording session (from start to 
stop). You can specify additional conditions for creating new files during a recording, or you 
can manually split a file. In split mode, files are actually saved immediately after recording 
has stopped, or a new file has been automatically created. In split mode, you must manually
save a file if it was modified after your recording has been stopped.

Split mode can be set for both regular recording and for recording during a scheduled job. 
Split settings for regular and for scheduled recording are independent.

To activate and set split mode options, take the following steps.

For a regular recording:

1. Select the "Split mode" check box on the "Split" tab (see "Using the Split Tab" section).
2. Press the "Conditions..." button. 

3. Set the required options on the "Split recording conditions" dialog (see "Using the Split 
recording conditions Dialog" section).

For a recording during a scheduled job:

1. To activate split mode recording during a scheduled job, select the "Split file according to
the specified conditions" check box on the "Scheduled Item" dialog (see "Scheduling a 
Job" section).

2. Press the "Conditions..." button. 
3. Set the required options on the "Split recording conditions" dialog (see "Using the Split 

recording conditions Dialog" section).

Files that are created in split mode are initially named based on settings in the "File name 
generation rules" dialog. For more information on file name generation rules, refer to the 
"Specifying File Name Generation Rules" section.

Turning on split mode causes the "Save the old one with confirmation, if not saved" option to
be set automatically (see "Using the Open/Save Tab").

Using the “Split now” feature

The “Split now” feature lets you immediately split a file. You can use this feature by choosing
the “Play/Record->Split now” menu item or by clicking the “Split now” ( ) toolbar button. 
When you use “Split now”, the current file is closed and recording to a new file begins. 

Note: You can use this feature only when you are recording in split mode.



Using the Split recording conditions Dialog (Professional and Developer Editions 
only)

The dialog looks like the following.

The dialog lets you set additional conditions for which a new file is created during a 
recording. If you specify more than one condition, a new file is created as soon as one of the 
specified conditions is true.
for each new sound format (fixed option) – a new file is created if the sound stream 
format differs from the format of the previously recorded sound. This option is fixed – you 
cannot disable it. If a specific format is set for a recording, then the sound stream format 
cannot differ from a format of previously recorded sound and the condition does not fire. The
condition can be true only if recording is performed in Software mode and the “Convert using
parameters specified below” option (see "Setting Recording Parameters" section) is not set.
for each software sound stream – a new file is created for each new sound stream being 
recorded in software mode. Setting this option can be useful if you want to write each sound 
stream to different files. For example, if you are using WinAmp to play a playlist, you can 
play each song from the playlist in a different stream. If you set this option and start 
recording sound that is being played by WinAmp, each song from the playlist will be 
recorded to a separate file.

every nnn minutes of recording – a new file is created every nnn minutes of recording.

every nnnn megabytes of recording – a new file is created once the current file reaches 
nnnn megabytes in size.

if sound level does not exceed mmm % in nnn seconds. 
Do not create files shorter than kkk seconds. – a new file is created if the recording 
level during an interval of nnn seconds was less than mmm % of the maximum sound level.
This setting is useful, for example, when you record from an audio cassette and want to 
record each song to a different file. Setting the value of kkk seconds can help prevent Total 
Recorder from saving long intervals between songs.

To set limits on an overall recording session, refer to the "Using the Advanced stop recording 
conditions Dialog" section.



Using a Scheduler overview
Total Recorder lets you program jobs (recording or playback) to start at a given time, similar 
to programming your VCR. You can either use Total Recorder's built-in scheduler or use 
command line options with an external scheduler, such as Microsoft Task Scheduler. The 
preferred method is to use the built-in scheduler because it lets you set all the parameters 
using a GUI and you can set different parameters for each job.

To start the built-in scheduler:

From the “Options” menu, select "Schedule…", or press the  button on the main 
toolbar. You are presented with the “Record/Play Schedule” dialog box.

To use an external scheduler:

Put Total Recorder as one of the scheduled tasks using the appropriate command line 
parameters. These command line parameters are described in the section "Using the 
Command Line".

The Total Recorder Log contains a list of all messages relating to jobs scheduled by the built-
in scheduler or initiated through the command line. For information on this log, refer to the 
section "Using the Total Recorder Log".



Launching Scheduled Jobs
Launching of a scheduled job starts one second before the scheduled time. The actual 
starting time depends on the speed of your computer but one second is usually more than 
enough to start a program. A scheduled job stops at exactly the scheduled time regardless 
of the time it was started.

For each scheduled job, a new copy of Total Recorder is launched regardless of another copy 
being present. This copy closes after the job is finished except in the following two cases:

· you started the job with command line parameters (either explicitly or implicitly) that 
indicate the copy should stay active

· you interrupted the job.



Actions You Can Take During a Scheduled Job

During performing a scheduled job or a job initiated from the command line, all buttons and 
menu items are disabled except:

· the Interrupt work ( ) button on the Main toolbar
· the “Interrupt work” item on the “Play/Record” menu
· the “Exit” item on the “File” menu.
Clicking the  button, or selecting the corresponding menu item, stops the job. Already 
recorded information is put to a file, an error message “Job interrupted by user” is written to 
the Total Recorder Log, and Total Recorder stays active. When you use “Exit” from the “File” 
menu or close Total Recorder in any other way (e.g. Alt-F4), all of these actions are done 
after the program terminates.



Handling Errors and Other Problems
The Total Recorder sound driver is a component that checks the time and launches the Total 
Recorder program. If for some reason the driver is not installed, scheduled jobs will not be 
launched.

Error messages, such as "file does not exist", do not go directly to a user since a user is not 
always present. These messages go to the Total Recorder Log.

If recording was active but nothing was actually recorded, the empty file is not saved and a 
message "Nothing has been recorded" is written to the Total Recorder Log. This may happen 
if    "Software" was set as a source but none of the programs played sound during the 
recording time. The job is considered to perform normally if it was not interrupted.



Displaying and Controlling Scheduled Jobs
The "Record/Play Schedule" dialog shows a list of scheduled jobs. From this dialog you can 
control scheduled jobs and create new ones.

Select "Schedule" from the "Options" menu and you are presented with the following dialog:

Job – scheduled job types, "Play" or "Record". There is an icon to the left that reflects the job
status:

Icon Status

job should be performed
job is disabled

No icon job should not be performed because the time has 
passed, regardless of whether the job was actually 
performed

Status – the result of the job. For a repeated job (e.g. daily), the last result is displayed. You 
can view detailed results in the "Schedule item" window, accessed with the "Edit" button. 
This window is described later.

The Status field can be one of the following:
Status Explanation

Empty never run
Done job ran normally

Expired job did not run and never will because the time has already 
passed. Your computer being switched off at the scheduled time
for the job may have caused this. For repeated jobs, this will 
never be displayed. 

Interrupte
d

job was interrupted by a user

Error error during the job. The error message can be viewed in the 
"Schedule item" window.

Running Currently the job has been performed by another running 
instance of Total Recorder. It is also possible that the job was 



started but there is no information of a normal or abnormal 
termination. Your computer being switched off during the job 
may have caused this.

The Status field contains information from the Total Recorder Log. If records were 
deleted from the Total Recorder Log, either automatically or manually, they will not 
appear here. If all records for a particular job were deleted, the job will appear as if it had
never run.

Date – identifies when the job should run:

Date Explanation

Daily each day

Day of the 
week

each week on the given day 

YYYY.MM.DD the date when the job should run 

Start time – the time the job should start (in 24-hour format, hh:mm:ss).

Stop time – the time the job should finish (in 24-hour format, hh:mm:ss). If the "Stop time" 
is less than the "Start time", it is assumed that the "Stop time" belongs to the next day. For 
playing a file, you can omit the "Stop time" and the file will be played back once.

File – the name of the file being played or recorded. This is always a full path. When using 
automatic file name generation rules for recording, it shows “* Auto *” (if split mode is 
disabled) or “* Auto split*” (if split mode is enabled).

Controls

You can use the following controls from this dialog:

"Delete when done" box. If set, a job that finishes normally will automatically be 
deleted from the list.

"New" button. Open the "Schedule item" dialog for entering a new job.
"Clone" button. Build a new job by copying the current one and then open the    
"Schedule item" dialog for editing. This is useful, for example, if you need to schedule
a job to run on certain days of the week but not daily.

"Edit" button. Open the "Schedule item" dialog for detailed viewing and editing of 
job parameters.

"En./Dis." button. Current job switches between Enable and Disable status. An icon 
reflects the current status. A crossed icon means Disable and such jobs are kept in 
the list but are not started.
"Delete" button. Deletes current job, after confirmation.

"OK" button. Accept all changes.
"Cancel" button. Discard all changes. If any changes were made, confirmation is 



required.

You can perform some actions (e.g. delete, enable, disable) on multiple scheduled jobs. You 
can use the standard Ctrl+click and Shift+click operations to select/deselect scheduled jobs 
in the list.



Scheduling a Job
Use the "Schedule Item" dialog to schedule a job, either a recording or a playback.

1. Open the "Record/Play Schedule" dialog.
2. Use the "New" button to create a new job.

OR
Select a job and use the "Clone" button to copy the current job for editing. This is 
useful, for example, if you need to schedule a job to run on certain days of the week 
but not daily.

3. Use the following dialog to specify your requirements:

Job

You must specify the action. Select “Play” or “Record”.

Date

You can schedule jobs with the following frequency:
Frequency Explanation

Once one time. Specify year, month and day (in 
that order) when the job should start.

Daily each day 
Weekly each week. From the list you can select a 

day of the week, weekdays (Monday 
through Friday), or weekends (Saturday and



Sunday).

The "Now" button sets the current date and time as the moment when the job should start. 
The time when the job should stop is set as the current time plus one second. After that, you
can modify these parameters manually.
Time

You can specify a starting time and a stopping time:

· Start at – time (hours, minutes, and seconds) when the job should start. The job will be 
launched one second before the scheduled time. 

· Stop at – time (hours, minutes, and seconds) when the job should stop. This is required 
for recording and optional for playback. Zeros in this field means midnight and not the 
absence of a stop time. If the "Stop at" time is less than the "Start at" time, the activity 
(either play or record) will stop the next day. 

· If you want to specify a stopping time for playback, select the “Stop at” check box to the 
left, and enter your stop time. A file will be played continuously from the “Start at” time 
until the “Stop at” time, regardless of the length of the file. Without a stop time, the file 
will be played once.

Advanced (Professional and Developer Editions only)

This button activates the "Advanced stop recording conditions" dialog. For more information,
refer to the "Using the Advanced stop recording conditions Dialog" section.

Recording source and parameters

When you use this button the Recording source and parameters dialog appears. Refer to the 
"Setting Recording Parameters" section.
File properties (MP3 and Ogg Vorbis only)

This button is enabled only when you schedule a recording and conversion either to MP3 
(MPEG Layer 3) or Ogg Vorbis. When you click this button, either the MP3-file properties 
dialog appears (refer to the    "Using the MP3 properties Dialog" section), or the dialog for 
setting Ogg Vorbis tags appears (refer to the "Working with Ogg Vorbis tag " section).

File name

This specifies the name of the file you want to create or play: You can use these options:

Auto create filename (TRyyyymmdd_hhmmss) (Standard Edition only) – this may be 
used for recording only. A new file is created based on the current date and time when the 
job completes. The file will be placed in the Total Recorder current directory.

Auto create (Professional and Developer Editions only) – this can be used for recording only.
A new file is created based on the file name generation rules. You can set the rules by 
pressing the "Rules…" button.

Rules (Professional and Developer Editions only) – this can be used for recording only. 
This button activates the "File name generation rules" dialog. For more information refer 
to "Specifying file name generation rules" section.



Note: If a date or time is specified in the file name generation rules, then the date and time 
depends on your split mode setting. 

If split mode is active File names are generated during the creation of
files (i.e. the date and time are fixed when the 
first portion of sound data for the file is 
received) 

If split mode is not 
active 

File names are generated after the recording 
has finished (i.e. when saving the file).

Split file according to the specified conditions (Professional and Developer Editions 
only) – this may be used for recording only. This box enables or disables split mode. For more
information, refer to the "Using Split Mode" section. You can set Split conditions by pressing 
the "Conditions…" button.

Conditions (Professional and Developer Editions only) – this may be used for recording 
only. This button activates the "Split recording conditions" dialog. For more information, 
refer to the "Using the Split recording conditions Dialog" section.

This name – a file name for recording or playback. You can enter it manually or use the 
“Browse” ( ) button.

Normalize to ...%– you can normalize a recording, using the percentage indicated, before 
saving. This only applies when recording. The Scheduler lets you specify normalization for all
formats including compressed. It the latter case, the actual recording is in PCM format and 
will be normalized and converted when saving. Normalization is not possible if split mode is 
on.
When saving an automatically recorded file, Total Recorder overwrites an existing file with 
the same name and no message is written to the Total Recorder Log. If a file with a given 
name cannot be created (e.g. the directory does not exist) a message is put to the Total 
Recorder Log and all recorded information is lost. It is recommended you use automatic file 
name generation to decrease the risk of these errors.

Connect to Website and Play Internet transmission (Professional and Developer 
Editions only) - This feature can be used only for recording. This box causes the Internet 
transmission, selected through the “Tune” button, to be played when a scheduled recording 
starts. A play-URL is displayed below the check box. To specify the Internet transmission to 
play, use the "Tune…" button. For more information, refer to the "Tuning into Internet 
Transmissions" section.

Tune (Professional and Developer Editions only) – this button activates Total Recorder's 
mini-browser to tune into an Internet transmission. For more information, refer to the 
"Tuning into Internet Transmissions" section.

Connection (Professional and Developer Editions only) – this button activates the 
"Connection to Internet" dialog. For more information refer to the "Connecting to 
Internet" section.

After job completes, close all windows with following string in title: (Professional 
and Developer Editions only) - This box causes all windows with the specified string in 
their titles to be closed when the scheduled job completes. You can select this string from 
the drop-down list, or type it manually in the box at the right. This feature can be useful, and
sometimes required, if you need to close the player before the next scheduled recording 



starts.

Status - Lists all of the Total Recorder Log messages, in chronological order, for the current 
job. If a job has not started, this field is empty. The purpose of this field is to help you with 
scheduling. For example, if you edit an old job it can be useful to see if it has ever run and 
what the results were.



Tuning into Internet Transmissions (Professional and Developer Editions only)

Total Recorder can tune into an Internet transmission and have it play when a scheduled 
recording starts. To tune into an Internet transmission, enable the "Connect to Website and 
Play Internet transmission" option and press the "Tune…" button on "Schedule Item" dialog.

The Total Recorder mini-browser, similar to the following, appears:

Address – specify the URL you want to go to and press the "Enter" or "Go" button. You can 
use the “Browse” ( ) button to select and open local files.
Go, Back, Forward, Stop, Home buttons – same functionality as that of Internet 
Explorer.

Capture transmission – This button is used to capture Internet transmission. After pressing
this button, it changes from "Capture transmission" to "Abort capturing". If you decide to 
stop capturing, press the "Abort capturing" button.

To capture an Internet transmission, take the following steps:

1. Go to a page from which you can immediately launch playing. For example, you can 
launch playing from the page http://www.highcriteria.com/acme.htm immediately by clicking 
on an "Listen to Mayor's speech on increased pedestrian traffic" link.

2. Press the "Capture transmission" button.

3. Click a link to start playing (e.g. "Listen to Mayor's speech on increased pedestrian 
traffic" link).

4. Answer "Yes" to the question "Save URL … as location to play? …". The "Name", 
"Base page", and "Play address" fields in the “Transmission to play” group will be 



filled in.

5. Press the “Play” button to check if your transmission is being captured correctly.

Transmission to play group

Name – list of named transmissions. By naming a saved transmission, it can be easily 
selected from the list in the future.

Save as – assign a name to the transmission. This name appears in the "Name" list at 
the left.

Remove – remove a named transmission.

Base page – the page from which the transmission was captured. This field is filled in 
when capturing begins.

Go – pressing this button takes you to the page specified in the "Base page" field.

Play address – the address being used by Total Recorder to play transmission. This 
field is filled in when capturing begins. However, you can specify the field explicitly 
(e.g. extract it from another Internet-related program).

Play – pressing this button causes Total Recorder to perform the same actions as those
performed during scheduled playing of the specified Internet transmission.

Notes:

· If a transmitting server requires registration procedures, you must complete these 
before using Total Recorder's mini-browser to access the server.

· Playing a transmission could cause some external player (e.g. WinAmp or Windows 
Media Player) to be launched.

· It is not guaranteed that you will successfully capture or play every Internet 
transmission.

· It is recommended you use the "Play" button to test captured or manually entered 
transmissions.



Connecting to the Internet (Professional and Developer Editions only)

If you choose to play an Internet transmission during a scheduled recording, you may want 
Total Recorder to connect/disconnect to your Internet Service Provider (ISP) by dial-up line. 
You can do this by setting parameters in the "Connection to Internet" dialog. 

The dialog looks like the following:

Connect to Internet using … - enables or disables connection to your ISP by dial-up line. 
You must choose a particular ISP from the list or use "[Default connection]". If you choose 
"[Default connection]", then Total Recorder will try to connect to the Internet through the ISP 
which is set in Internet Explorer as your default connection.
If a connection to the Internet is established at the same time a scheduled job starts, then 
Total Recorder will not try to establish a new connection.

After scheduled job completes

Select one of the following options:

Do not disconnect. Total Recorder will not disconnect from the ISP after a scheduled 
job completes.

Disconnect if connection established by the scheduler. Total Recorder will 
disconnect from the ISP after a scheduled job completes only if Total Recorder's 
scheduler established the connection to the ISP.

Always disconnect. Total Recorder will disconnect from the ISP after a scheduled job 
completes regardless of which program established the connection to the ISP.

Notes:

· Your dial-up entries must be set correctly.

· Since a scheduled job does not require user intervention to execute the job, your 
connection to your ISP must not require that you enter any information such as a 
user name or password.

· You should try to make a connection in test mode before using connection 
capabilities for regular connection.



Using the Command Line
Performing a job specified in the command line is similar to performing a job started by the 
built-in scheduler. From the command line, you can play or record a file.
General Command Line Syntax

The syntax of Total Recorder's command line is:
TotalRecorder [Filename] [/Play|/Record] [/Time:[[hh:]mm:]ss] 
[/Normalize[:percent]] [/Noclose]

A file name, if specified, must be the first parameter. Other parameters can be in any order.

Filename Parameter

The name of the file you want to load, play or record. If the name contains spaces, enclose it
within double quotes (e.g. "My Recordings").
/Play Parameter

Play a file. The filename is mandatory.
You can use the abbreviation - /P.

/Record Parameter

Perform recording. The current source and recording parameters will be used. If a file name 
is specified the result will be saved with this name. Otherwise, a name in the form of 
TRyyyymmdd_hhmmss.WAV will be generated based on the current date and time. The 
file will be placed in the Total Recorder current directory.
For recording, duration must be specified using the /Time parameter.

You can use the abbreviation - /R.

/Time Parameter
Specifies the duration of recording or playing. This is required for recording.
If you omit this parameter for playing, the entire file will be played once. If you specify this 
parameter for playing, a part of a file may be played or the playing may be repeated as 
necessary. For example, if you schedule a 4-minute file to play for 10 minutes, it will play 2 
½ times. Or if you schedule a 10-minute file to play for 4 minutes, only the first 4 minutes of 
the file will play.

You can use the abbreviation - /T.
There are three different ways to specify duration. The following examples each specify the 
same duration (1 hour, 1 minute, and 1 second):

· /T:hh:mm:ss, for example: /T:1:01:01 or /T:1:1:1

· /T:mm:ss, for example: /T:61:01 or /T:61:1

· /T:ss, for example: /T:3661

The following are examples of incorrect formats:



· /T:1:61:01 - since mm cannot exceed 59

· /T:2:60 - since ss cannot exceed 59

/Normalize Parameter

This parameter causes Total Recorder to normalize the file to a given percentage after it is 
recorded. You can specify a value from 1 to 999. The default is 100%. For example: 
/Normalize:95 .
You can use the abbreviation - /Norm.

/Noclose Parameter

This parameter causes Total Recorder to stay active after the job is done. If not specified, 
Total Recorder will close except in the case where neither /Play nor /Record were specified.
You can use one of the abbreviations - /NC or /N.

Examples

Perform recording for five minutes, save the result in a file with an automatically generated 
name and do not close the program: 

TotalRecorder /R /T:5:00 /NC

Play a sound file and close the program:

TotalRecorder C:\MyFolder\MySoundFile.WAV /P

Play a bell (Ring.WAV) continuously for one minute:

TotalRecorder C:\MySoundDir\Ring.WAV /P /T:60

Start Total Recorder and load a sound file. You can then use the "Play" button to play the file:

TotalRecorder    "C:\My folder\My sound file.WAV"



Using the Total Recorder Log
The Total Recorder Log contains a list of all messages relating to jobs scheduled by the built-
in scheduler or initiated through the command line or auto stop. This log sits in the registry 
and unlimited expansion is not desirable. By default, all records older than one week will be 
automatically deleted.

Some errors cannot be written to the Total Recorder Log, for example, errors when writing to 
the registry and syntax errors in command line parameters. These errors will not occur when
working with the built-in scheduler.

To review or control information in the Total Recorder Log, select "View log" from the "File" 
menu. You are presented with the following dialog:

Message list

The list contains all messages, in chronological order, relating to jobs scheduled by the built-
in scheduler or initiated through the command line. For each job it includes the starting time,
ending time, and all error messages. Scheduler messages are marked with the letter "S"; 
command line messages and auto stop related messages are marked with the letter "P". The
current message is displayed below the list.

Controls

You can use the following controls from this dialog:

· Auto delete after – controls the automatic deletion of obsolete records. This is the 
default mode. Switching it off is not recommended because it will cause the registry to 
grow and decrease system performance.

· Day(s) – records will be deleted after this number of full days. Records are deleted at 
midnight on the expiry date or the next time your computer is on after this date. For 
example, "0" means that only records from the current day are accessible, "1" means 
that records will be kept for one full day and deleted at midnight the following day, and 
so on.

· Clear all – delete all records. Confirmation is required.

· Close – close the dialog. All changes are made immediately.





File menu
Menu Item Edition Action Button Shortcut

New All Create a new file Ctrl+N
Open All Open an existing file Ctrl+O
Save All Save an open file using the 

same file name. See 
"Saving a Recording".

Ctrl+S

Save as All Save an open file using a 
new file name. See "Saving 
a Recording".

None None

Save selection 
as

All Save selection to a file. See 
"Editing a Sound File".

None

Delete current 
file

PE, DE Delete current file None None

Properties All Display properties of 
current file. See Displaying 
File and Recording 
Properties.

None None

Tag All Display/add/delete/edit an 
ID3 tag or an Ogg Vorbis 
tag. See Using the MP3 
properties Dialog.and 
Working with Ogg Vorbis 
tags 

None None

View log All View the Total Recorder Log.
See "Using the Total 
Recorder Log"

None None

Exit All Exit Total Recorder None Alt+F4

Edit menu
Menu Item Edition Action Button Shortcut

Undo All Undo previous operation Ctrl+Z
Redo All Redo the previously 

undone action
Shift+Z

Cut PE, DE Delete selection and place 
it to the Clipboard

Ctrl+X

Copy PE, DE Copy selection to the 
Clipboard

Ctrl+C

Paste PE, DE Paste data from the 
Clipboard to the current 
recording

Ctrl+V

Delete 
selection

PE, DE Delete selection Delete

Delete except PE, DE Delete data except what is Ctrl+Delete



selection selected
Insert a file at 
current position

PE, DE Insert a file at current 
position

None None

Selection All Selection submenu. See 
"Selection Sub-menu".

None None

Stop playing at 
selection 
boundary

All Stop playing at nearest 
selection boundary

P

See also "Editing a Sound File".



Selection Sub-menu
Menu Item Edition Action Button Shortcut

Set beginning 
of selection

All Set left selection boundary 
as the current position of 
the slider

Shift+L

Shift beginning 
of selection left
by 0.1s

All Shift beginning of selection
left by 0.1s

Shift+M

Shift beginning 
of selection 
right by 0.1s

All Shift beginning of selection
right by 0.1s

Shift+N

Go to 
beginning of 
selection

All Move current position of 
slider to left selection 
boundary

L

Set end of 
selection

All Set right selection 
boundary as the current 
position of the slider

Shift+R

Shift end of 
selection left 
by 0.1s

All Shift end of selection left 
by 0.1s

Shift+S

Shift end of 
selection right 
by 0.1s

All Shift end of selection right 
by 0.1s

Shift+T

Go to end of 
selection

All Move current position of 
slider to right selection 
boundary

R

Select all All Select entire sound data None Ctrl+A
Toggle 
selection off

All Toggle current selection off Ctrl+Shift+
C

See also "Using the Selection Panel".



View menu
Menu Item Edition Action Button Shortcut

Show selection All Show/Hide Selection panel.
See also "Using the 
Selection Panel".

None None

Show sound 
image

PE, DE Show/Hide Sound Image 
panel. See also " Working 
With Sound Image".

None None

Play/Record menu
Menu Item Edition Action Button Shortcut

To start All Rewind to the beginning None
Left by… All Move current position to 

the left with a fixed step 
Ctrl+L

Right by… All Move current position to 
the right with a fixed step 

Ctrl+R

To End All Fast forward to the end None
Jump to time All Jump to specified location Ctrl+J
Play selection All Play back a selected 

fragment of a file
None Ctrl+E

Play All Play file. See "Playing a 
sound file"

Ctrl+Y

Pause/Continue All Pause or continue playing 
or recording file

Ctrl+U

Stop All Stop playing or recording a
file

Ctrl+P

Record All Start recording. See 
Starting Recording.

Ctrl+R

Split now PE, DE Split current recording 
immediately

Ctrl+I

Append 
recording mode

PE, DE Switch to Append 
recording mode. See 
"Using the Open/Save Tab".

None

Insert recording
mode

PE, DE Switch to Insert recording 
mode. See "Using the 
Open/Save Tab".

None

Pre-recording 
… last seconds

All Turn pre-recording mode 
on or off. See "Using Pre-
recording mode"

None Ctrl+G

Clear pre-
recording 
buffer

All Clear the pre-recording 
buffer. See "Using Pre-
recording mode"

None Ctrl+B

Auto stop All Set or reset auto-stop None None



recording recording mode. See Using
Auto Stop Mode.

Interrupt work All Interrupt current job. See 
Actions you can take 
during a Scheduled Job and
Using the command line.

None

Volume menu
Menu Item Edition Action Button Shortcut

Normalize All Normalize the volume of a 
sound file. See Normalizing
a Sound File.

None None

Options menu
Menu Item Edition Action Button Shortcut

Settings All Configure Total Recorder. 
See Configuring Total 
Recorder overview.

None

Recording 
source and 
parameters

All Set recording source and 
parameters. See Setting 
recording parameters.

-//- None

Schedule All Display and control 
scheduled jobs. See Using 
a Scheduler overview, 
Displaying and controlling 
Scheduled Jobs, Scheduling
a Job.

None

System 
settings

All Show Multimedia panel 
with system settings

None None

Help menu
Menu Item Edition Action Button Shortcut

Help Topics All Index to help topics None None
Internet Links All Display a page of links to 

MP3 and Ogg Vorbis 
software. See Working with
MP3 format and Using the 
Ogg Vorbis Tab.

None None

Registration All Register program. See How
to obtain a registration 
key.

None None

About Total 
Recorder

All Display the version 
number, edition, and 
registration information

None None



Symptom - Unable to Play Simultaneous Sound Streams
After the installation of Total Recorder your computer lost the ability to play several sound 
streams simultaneously. This applies only to some very advanced sound cards that are 
capable of playing multiple streams or if your computer has more than one sound card.

Possible Cause #1
During the Total Recorder installation, its driver is set as a preferred device and the "Use 
preferred devices only" flag is set. This flag disables playing multiple sound streams. Some 
programs (e.g. Windows Media Player) need this flag to be set in order to work correctly with
Total Recorder (see next symptom, Possible Cause # 3).

Action #1
Select "Start"- "Settings"- "Control Panel" (for Windows XP select "Start"- "Control Panel") - 
"Multimedia" (or "Sounds and Multimedia", or "Sounds and Audio Devices") (or from the Total
Recorder menu, select "Options"- "System settings"), tab "Audio", and uncheck the box "Use
preferred devices only".    If this causes a problem after recording a program, you will need to
turn it on during recording and then turn it off when you are done. Or you can set mode to 
turn on the Total Recorder driver only when Total Recorder is running. For more information, 
refer to the "Using the System Tab" section. In this case you should uncheck the "Use 
preferred devices only" flag, in order to turn it off automatically when Total Recorder finishes.



Symptom - No sound recorded
Sound is reproduced but Total Recorder does not record it. The slider remains at the left 
edge and the "Length (sec.)" counter does not change.

Possible Cause #1
Some playback programs do not perform a system inquiry for the default sound driver; they 
explicitly indicate the driver they need. These programs may be older, obsolete programs or 
may use special functions of specific devices. It is not possible to set the system to ignore 
these direct requests and sounds reproduced by such programs will not be recorded. 

Action #1
Change the playback program where possible.

Possible Cause #2
Some programs (e.g. Internet telephony) have the ability to select the necessary audio 
driver manually and ignore system settings.

Action #2
Read the program manual and set the Total Recorder driver as both the driver for playing 
and recording.

Possible Cause #3
Total Recorder's driver perceives a sound stream in main wave-format (PCM, pulse-coded 
modulation) only. If the reproducing program sends a sound stream in any other format (e.g. 
compressed), Windows usually calls the decoding drivers itself to perform all of the required 
translation. However, if your sound card can make some translation at the hardware level, 
then Windows can direct the sound stream to the driver of such a sound card immediately, 
and bypass Total Recorder's driver. As a result, sound cannot be recorded. 

Action #3
Select "Start"- "Settings"- "Control Panel" (for Windows XP select "Start"- "Control Panel") - 
"Multimedia" (or "Sounds and Multimedia", or "Sounds and Audio Devices") (or from the Total
Recorder menu, select "Options"- "System settings"), tab "Audio", and check the box "Use 
preferred devices only". This eliminates the use of any device other than the default one. 

Possible Cause #4
The mode "Preferred audio devices when Total Recorder isn't active" - "Audio playback and 
recording devices selected above" is turned on. In this case, if the playing back of the sound 
you are attempting to record was started before Total Recorder was started, the playback 
program does not use the Total Recorder driver. You have changed playback or recording 
preferred device either manually or it has been done after the play back was started.

Action #4
Without closing Total Recorder, close the playback program and restart it. Try to make your 
recording again.    Remember if the mode of automatic driver switching is turned on, you 
should start Total Recorder first and only after that should you start the playback program 
from which you are going to record sound.



Symptom - Sound recorded with gaps
Sound is recorded with gaps.

Possible Cause #1
Total Recorder does not have enough time to record sound. This can happen on slow 
computers or when a slow device (e.g. a diskette) is used as a destination device for the 
temporary recording file. 

Action #1
Use a faster device for storing temporary files.

Possible Cause #2
The Playback program's buffer is bigger than Total Recorder’s driver buffer. In this case all 
sound will be omitted. The "sec. lost" counter will grow while the "Position (sec.)" counter 
will remain at 0. This situation is extremely unlikely since Total Recorder’s buffer should be 
big enough. 

Action #2
Go to the URL: http://www.highcriteria.com/support.htm.

Possible Cause #3
Your computer is overloaded with other jobs.

Action #3
Select "Options"- "Settings", "System" tab and enable the "High priority" setting.

Possible Cause #4
There are incompatibility problems between your soundboard and hard drive controller. This 
may occur in Sound Board mode when using some soundboards with recordings of a long 
duration.

Action #4
Select "Options"- "Settings", "Open/save" tab and disable the "Flush the temporary file every
XX seconds" setting.



Symptom - Sound system or playback programs not working properly
After installing Total Recorder, the sound system or some playback programs are not working
properly, even when Total Recorder is not active. 

Possible Cause #1
There is an incompatibility with Direct Sound. When a playback program uses Direct Sound, 
the sound can sometimes be garbled. 

Action #1
Many modern programs can be set up to optionally use Direct Sound. Read the program’s 
help to determine the required settings.

Possible Cause #2
The Total Recorder driver is not compatible with other installed programs.

Action #2
Describe your system configuration and the nature of your problem via E-mail to High 
Criteria Inc. This will help eliminate the problem in future releases.

You cannot record from a conflicting playback program. However, you can eliminate the 
conflict when Total Recorder is not active by using the Total Recorder driver as a preferred 
device only when necessary. This can either be done automatically; each Total Recorder 
starts up and shuts down, or manually. Automatic switching is simpler.

To automatically switch preferred devices:

Use the "Options"- "Settings", "System" tab, and set "Preferred audio devices when 
Total Recorder isn't active" as "Audio playback and recording devices selected 
above". For more information, refer to the "Using the System Tab" section.

To manually switch preferred devices:

1. Leave the default setting for "Preferred audio devices when Total Recorder isn’t 
active" as "Total Recorder driver (recommended)". Total Recorder will not switch 
devices and will not check the settings until it needs some service from its driver (i.e. 
during a recording from source "Software").

2. Use the Windows system dialog ("Start"- "Settings"- "Control Panel" (for Windows XP 
"Start"- "Control Panel"), "Multimedia" (or "Sounds and Multimedia", or "Sounds and 
Audio Devices"), "Audio tab", or use the Total Recorder menu items ("Options"- 
"System settings"), and select the devices that were set before the installation of 
Total Recorder. If you are unsure what to select, review the Total Recorder settings: 
"Options"- "Settings", "System" tab, "Audio playback and recording devices".

3. For recording sources other than "Sound board", you must make either one or two of 
the Total Recorder virtual devices (i.e. playback and recording) your preferred devices
before you start the playback program you would like to record. 

· If you record from "Software" and "Record also input stream" is not checked, the 
device "Playback through Total Recorder" must be your preferred playback device.

· If you record from "Software" and "Record also input stream" is checked, the 
device "Playback through Total Recorder" must be your preferred playback device,



and the device "Record through Total Recorder" must be your preferred recording 
device.

4. If Total Recorder needs a device that is not set as a preferred device when you start a
recording, the recording does not begin and the system dialog pops up.

5. After your recording is finished, you can return the original preferred devices so that 
Total Recorder will not interfere with any other software.



Other Problems
If you experience problems with Total Recorder that you cannot resolve yourself, visit the 
support area at http://www.highcriteria.com/support.htm. You should read Frequently Asked 
Questions at http://www.highcriteria.com/faq_tr.htm before sending a letter to support.

When addressing the Technical Support Team, it is recommended you include a description 
of the problem and debug information. The following are some guidelines on the steps to 
take for different types of problems.

If the problem appears through an error message displayed in Total Recorder or 
its install program:

1. Press the "Debug info>>" button in the message box.

2. Press the Copy button in the message box. Debug information will be copied to the 
Clipboard. The size of this information will not exceed 20 kilobytes.

3. Insert the information from the Clipboard into your letter to the Technical Support Team.

If the problem does not appear with a Total Recorder error message:

1. Do not close Total Recorder. Go to the "Options"->"Settings"->"Debug" tab.
2. Press the "Copy all" button of the "Internal debug info" group. Debug information will be 

copied to the Clipboard. The size of this information will not exceed 20 kilobytes.
3. Insert the information from the Clipboard into your letter to the Technical Support Team.

If you cannot use the previous instructions or the problem is not directly related 
to Total Recorder (e.g. problem occurs in another programs):

1. Run Total Recorder and go to the "Options"->"Settings"->"Debug" tab.
2. Press the "Copy all" button of the "Internal debug info" group. Debug information will be 

copied to the Clipboard. The size of this information will not exceed 20 kilobytes.
3. Insert the information from the Clipboard into your letter to the Technical Support Team. 




